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Before You Begin

Welcome to the COMSOL Installation Guide, which provides instructions on
how to install COMSOL Multiphysics® and its add-on products. In addition to
this manual, several on-line resources are available which are relevant for
installation:

e System Requirements: www.comsol.com/system-requirements

¢ Support Knowledge Base: www.comsol.com/support/knowledgebase
e Support Center: www.comsol.com/support

e Software License Agreement: www.comsol.com/sla

® Product Download: www.comsol.com/product-download

¢ Product Updates: www.comsol.com/support,/updates

e COMSOL Video Gallery: www.comsol.com /video

Installation Media Options

There are four installation media options for COMSOL 4 .4:
¢ Installation over the Internet:

- This option requires Internet access from the computer where COMSOL is
to be installed.

e Installation from downloaded DVD image:
- This option requires Internet access from any computer for downloading the
DVD image file with a .iso file extension.
e Installation from a DVD given to you by a COMSOL representative:
- This option requires access to a DVD reader on the computer where
COMSOL is to be installed.
e Installation from a USB Flash Drive given to you by a COMSOL
representative:
- This option requires a USB port on the computer where COMSOL is to be
installed.

Installation using any of these four options is explained later in this document.
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System Requirements

COMSOL is a cross-platform software that runs on the Windows®, Mac®, and
Linux® operating systems. A variety of hardware platforms are supported,

including graphics cards. Before installing, make sure your computer meets the
current system requirements listed at: www.comsol.com/system-requirements.

There is also a current list of compatible software versions for:
¢ External function C compiler

e COMSOL API for use with Java®

e LiveLink™ for MATLAB®

e LiveLink™ for Excel®

e CAD Import Module

e LiveLink™ for SolidWorks®

e LiveLink™ for SpaceClaim®

e LiveLink™ for Inventor®

e LiveLink™ for AutoCAD®

e LiveLink™ for Creo™ Parametric
e LiveLink™ for Pro/ENGINEER®
e LiveLink™ for Solid Edge®

e File Import for CATIA® V5

Previous Installations

Previous installations of COMSOL on your computer are not affected by your
new COMSOL 4 .4 installation except that double-clicking a Model MPH-file
opens in the latest installation (unless otherwise specified during installation). You
can continue to use other versions or uninstall them independently of the latest
installation.

In this guide, the term COMSOL 4.4 refers not only to COMSOL
Multiphysics 4.4 but also to any of the add-on products.
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Software License Agreement

For the complete software license agreement with details on the license
conditions, please refer to the COMSOL Software License Agreement. The PDF
can be downloaded from this link: www.comsol.com/sla. The license agreement
is also available in your installation folder. On Windows, it is located at:

C:\Program Files\COMSOL\COMSOL44\
doc\pdf\comsol\COMSOL_SoftwareLicenseAgreement.pdf

and can also be accessed from the Windows Start menu, under
COMSOL 4.4>Documentation.

On Mag, it is located at:
/Applications/COMSOL44/doc/pdf/comsol/COMSOL_SoftwarelLicenseAgreement.pdf

On Linuyx, it is located in the installation directory, for example:
/usr/local/comsol44/doc/pdf/comsol/COMSOL_SoftwareLicenseAgreement.pdf

License Types

There is a variety of license options, and the steps involved when installing can
differ depending on which license type you have acquired. No license type restricts
usage to just one operating system but you are able to choose to install on either
Windows, Mac, or Linux. A COMSOL model file saved on one platform can be
opened on another. Certain license types come with restrictions; make sure you
know which license type you have before proceeding with the installation.

All COMSOL licenses allow for multicore /multiprocessor
shared-memory computing. How many cores or processors you can utilize
is only limited by your hardware configuration and operating system. In
the COMSOL Desktop you control the number of processors from the
Options menu, under Preferences>Memory and processors.
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The picture below summarizes the license types and their usage:

License Type  Multiple Computers  Multiple Platforms Multiple Users Client/Server Clusters Cloud Computing
NSL Yes Yes No No No No
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All of the license types may not be available in your region.

For a full description and definition of the different license types, see the
COMSOL Software License Agreement.

The following summary gives an overview of the different license types:

Named Single User License (NSL)

This license type permits one physical person designated to COMSOL by name to
run a session of the software. This designated user can be replaced on a temporary
or permanent basis provided that only one individual is designated to COMSOL
as the user at any given time. A Named Single User License cannot be used or

accessed over a network with tools such as Windows Remote Desktop or similar.

CPU-Locked Single User License (CPU)

This license type permits you to install the software on one computer, and
different users can take turns using COMSOL on that computer, one session at a
time. A CPU-Locked Single User License cannot be used or accessed over a
network with tools such as Windows Remote Desktop or similar.

Floating Network License (FNL)

This license type is intended for multiple users and is licensed per concurrent user.
You can install the software on as many computers on your network as you want
and these computers can have different operating systems (one being a Windows
PC, another running Mac, a third running Linux, and so on).

As a user of a Floating Network License, you can run COMSOL in several ways:
® On your local computer

e On a remote computer accessed over a network
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¢ In Client-Server mode, where you run only the COMSOL Client locally and
the COMSOL Server elsewhere on the network, usually on a more powerful
computer. The COMSOL Client is essentially the COMSOL Desktop
environment whereas the COMSOL Server is the COMSOL computational
engine needed for solving.

¢ On a cluster or cloud with no restrictions on the number of compute nodes.

In any of the Floating Network License usage scenarios above, the FlexNet™

license manager software (shipped with COMSOL) needs to be installed and run

on a computer somewhere on the network.

Class Kit License

The Class Kit License can be installed and used by up to 30 students including up
to two teaching assistants. This type of license is for classroom use only and
requires a central license administrator person.

Trial License

This license type can be either a Single User License or Floating Network License
with the intention to test the software without any payment obligation for
noncommercial and nonproduction use.

License Management Tools

The FlexNet License Manager Software

Depending on your region and operating system, any of the above license types
may require that the FlexNet license manager software is installed and started
before running COMSOL. The FlexNet license manager comes bundled with any
COMSOL installation. You can view the contents of the license file (1icense.dat)
that you received from your COMSOL representative by opening it with a text
editor or word processing software. If the file contains a line starting with the word
SERVER, then the FlexNet license manager is required. For a Floating Network
License, the purpose of the FlexNet license manager software is to count the
number of concurrent users and to give an error message if the number of users
exceeds the licensed number of concurrent users. Depending on your region and
operating system, the FlexNet license manager software might also be needed for
a Single User License. In that case, the purpose of the license manager software is
to lock the COMSOL session to a COMSOL authorized computer. See “License
Manager Installation on Windows” on page 33 for more information. The
COMSOL software products and the license manager can be installed in any
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order, except if you are installing based on a port number and host name. In that
case, the license manager software needs to be installed and started before
installing COMSOL.

Dongle Hardware Lock

Depending on your region and operating system, any of the above license types
might require a dongle (hardware lock). If you have received a dongle to use with
COMSOL, please refer to instructions given to you by your COMSOL
representative.

COMSOL Access

COMSOL Access is a service provided by COMSOL that gives you access to
additional content on www.comsol.com and allows you to:

e Download products
e Update products (restricted to customers with an active subscription)
e Edit contact and license information

e Access the Knowledge Base (unabridged access to all parts is restricted to
customers with an active subscription)

e Contact technical support

* Manage event registrations

e Manage abstract submissions to the COMSOL Conference
e Access to the COMSOL Exchange on-line model sharing
e Participate in the Community Discussion Forum

Registering with COMSOL Access is required for product download and
installation.
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Installing on Windows

Installation Over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without
any payment obligation for noncommercial and nonproduction use. This option
is not available in all regions.

Installation of a Single User Trial License on Windows requires a license passcode.
A passcode has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

This is usually sent to you by a COMSOL representative by email. Once you locate
your passcode, follow these steps to prepare for download and installation:

I Click the link for downloading the software as given in the software download
email from your COMSOL representative. This link is identical or similar to:
www.comsol.com/support/download /trial.

2 If you haven’t already created a COMSOL Access account, you will be
prompted to create it. While creating the account, enter your trial passcode to
associate it with your account information.

If you already have created a COMSOL Access account, then the link
www.comsol.com /support/download /trial directs you to a page where you
can enter the passcode:

3 Follow the web-based instructions to download the software.

4 Continue with the instructions in the section “Downloading the COMSOL
Installer” on page 10.

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on Windows requires a license file that is sent
to you by your COMSOL representative by email. To be able to generate the
license file, information about your hardware is needed in the form of a hostid
(host ID). The hostid is used to lock the license to your hardware and needs to be
sent by you to a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid
Follow these steps to obtain a hostid:

I First open the command window by pressing the keyboard Window button+R.
If you don’t have a Window button, click the Start button, enter cmd in the
search box, and press OK or Return.

2 Enter ipconfig /all at the command prompt and press Return. The displayed
information looks similar to this:

B8 Administrator: C\Windows\system32\cmd.exe |E|%

Microsoft Windows [Uersion 6.8.600811
Copyright <(c> 2BA6 Microsoft Corporation. All rights reserved.

C:\Users\Paul>ipconfigrall
Windows IP Configuration
Primary Dns Suffix
Hode Type
IP Routing Enabled
WINE Proxy Enabled.
DHS Suffix Search Lis
Ethernet adapter Local Area Connection:

Connection—specific DNE Suffix

n
Description = B reme 57xx Gigabit Controlle

Physical Address
DHCP Enahbled

Autoconfiguration Enabhled . . . .

Link-local IPub Addre 9a:78%a:5936:6b3029 (Preferred>
IPv4 Adde s = 9{Preferred)

Subnet M 3] 55.8.8

Leasze Obtaine Tuesday, September 23, 2008 B9:48:4%
Lease Expires Thursday,. September 25. 2888 12:26:42
Default Gateway 18.8.48.1

DHCP Sepver 18.0.08.25

DNS Servers 168.A.8.1

HetBIOS over Tcpip Enabled

C:\Users Paul>

L 4

3 The hostid you are looking for is here called Physical Address, also known as
Ethernet address or MAC address.

To place the number on the Windows clipboard, right-click the text in the
command window and select Mark in the menu, mark with the mouse, and press
Return. Alternatively, you can type the command:

getmac /FO LIST /V | clip

which also places the information on the Windows clipboard.

4 Now press Ctrl+V to paste the hostid to the text body of an email to be sent to
a COMSOL representative.

Obtaining the Host Name

If you have been informed by your COMSOL representative that you need to run
the FlexNet license manager for your installation, then you also need the Host
Name. The Host Name is encircled in the screen shot above. If your network
administrator prefers to use a fixed IP address for this particular computer, this IP
Address can be optionally used in place of the Host Name. For more information
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on license manager installation see “License Manager Installation on Windows”
on page 33.

Hostid for PCs with Wireless Adapters

If you plan to install on a computer with a wireless network adapter, you need the
physical address of both the wireless and the Ethernet adapter. If the COMSOL
representative asks you for the hard disk serial number instead of the hostid, type
vol at the Windows command line prompt. The output looks like

Volume Serial Number is 2C9F-5930

Obtaining the License File from a COMSOL Representative

Send the hostid information, as well as Host Name, if applicable, in an email to
your COMSOL representative, who will respond with an email with an attached
license file (1icense.dat). Save this file to any location on your computer. You
need to refer to it during installation. The license file is a text file and below is an
example of the contents of a license.dat file for a Single User License on
Windows. This example license file shows that the licensed products are
COMSOL Multiphysics, Particle Tracing Module, Subsurface Flow Module, and
LiveLink™ for Excel®.

# COMSOL 4.4 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions

FEATURE SERIAL LMCOMSOL 4.32 permanent uncounted \
VENDOR_STRING=C, 18000100200 HOSTID=ANY sort=100 SN=1234567 \
TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 4.32 permanent uncounted HOSTID="70f2b12f4dfd \
0116b8cc761a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1al12f4dfc 0026b9cc760a" PLATFORMS="1i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 4.32 permanent uncounted HOSTID="70f1a12f4dfc \
0026b9cc760a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited or changed in any way by
the user but has to be identical to the one sent to you by a COMSOL
representative. If you were sent a license file that requires a license manager, then
minor edits are required. For information on the type of license file required for
installations using a license manager, see “The License File” on page 35.
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Registering with COMSOL Access

Once you have saved your license file, follow these steps to register or login to
COMSOL Access to start the installation:

I Click the link for downloading the software as given in the software download
email from your COMSOL representative. This link is identical or similar to:
www.comsol.com /product-download.

2 Ifyou haven’t already created a COMSOL Access account, you will be
prompted to create it. While creating the account, point to your license file
(license.dat) to associate it with your account information.

If you already created a COMSOL Access account, then you can associate the
license file with your account on the COMSOL Access page under Manage
Licenses at www.comsol.com /access /licenses

3 Continue with the instructions in the next section.

DOWNLOADING THE COMSOL INSTALLER
I Go to the web page www.comsol.com/product-download.

2 You are now given the option of installing COMSOL using the Online Installer.
(For the DVD option see “Installation from Downloaded DVD Image” on
page 11.) In addition, there are two further options of Compact Installation or
Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.

Selection one of the options for Compact Installation or Full Installation.

Clicking one of the install buttons starts the download of the COMSOL Installer.
For Windows, the file to download is called COMSOL44_win.exe for the Full
Installation and COMSOL44_compact_win.exe for the Compact Installation.
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STARTING THE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the
installation process. Start the COMSOL Installer by running one of the
downloaded files COMSOL44 win.exe or COMSOL44 compact_win.exe,
corresponding to the full and compact version, respectively. The COMSOL 4.4
Installer window should now appear. Now continue with the instructions in the
section “Running the COMSOL Installer” on page 13.

Installation from Downloaded DVD Image

Installation from a DVD where the DVD image is downloaded from COMSOL
for off-line installation requires you to first create a COMSOL Access account as
described in the section “Installation Over the Internet” on page 7.

I Once you are logged in to COMSOL Access, you are now given the option of
installing COMSOL using the Online Installer or to download the DVD Image
for Offline Installation. This section covers the DVD Image option. In addition,
there are two further options of Compact Installation or Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.

2 In the section for the DVD Image option, click one of the buttons for Compact
DVD Download or Full DVD Download. Clicking one of the install buttons starts
the download of the COMSOL DVD Image. The file to download is called
COMSOL44_dvd.1iso.

3 When you have downloaded the DVD image, burn the DVD image to a disc to
be able to install. In Windows 7 and Windows 8 you can burn by right-clicking
on the DVD image and selecting Open with and then Windows Disc Image Burner.
For earlier Windows versions you need a dedicated DVD burning software to
use this option. In Windows 8 you have the additional option of directly
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mounting the DVD image by right-clicking on the DVD image and selecting
Mount and then continuing directly with the installation. For earlier Windows
versions, you can use a dedicated DVD image mounting software to circumvent
burning to DVD.

STARTING THE INSTALLER FROM A DVD OR MOUNTED DVD IMAGE

The COMSOL Installer is a user interface tool that guides you through the
installation process. Once you have inserted the COMSOL DVD into the DVD
drive (or mounted the image), the COMSOL Installer window should appear
automatically; if not, run the file setup.exe on the installation DVD. The
COMSOL 4.4 Installer window should now appear. Now continue with the
instructions in the section “Running the COMSOL Installer” on page 13.

Installation from a DVD

This section applies if you have received a DVD from a COMSOL representative.

STARTING THE INSTALLER FROM A DVD

The COMSOL Installer is a user interface tool that guides you through the
installation process. Insert the COMSOL DVD into the DVD drive on your
computer. The COMSOL Installer window should appear automatically; if not,
run the file setup.exe on the installation DVD. The COMSOL 4.4 Installer
window should now appear. Now continue with the instructions in the section
“Running the COMSOL Installer” on page 13.

Installation from a USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the
installation process. Insert the USB Flash Drive into a USB port on your
computer. The COMSOL Installer window should appear automatically; if not,
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run the file setup.exe on the USB Flash Drive. The COMSOL 4.4 Installer
window should now appear. Now continue with the instructions in the section
“Running the COMSOL Installer” on page 13 below.

Running the COMSOL Installer

The steps for running the COMSOL Installer are independent of the installation
media option you used. If you have followed the above instructions, the
COMSOL Installer should now appear. The procedure is the same for Mac OS X
with the following exceptions:

COMSOL does not work if the path to the COMSOL folder, or the name
of the COMSOL folder itself, contain spaces.

You cannot browse to the MATLAB installation directory directly. You
need to enter it manually. MATLAB is installed in the /Applications
directory, for example, as /Applications/MATLAB_R2013b.app.
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I Select your language for the installation and click Next.The language you select
will also become your default language in COMSOL.

COMSOL 4.4 INSTALLER ARCORASOL

Please select language for installation

() ¥R 37 (Traditional Chinese)
@ English

() Frangais (French)
(©) Deutsch (German)
(@) Ialiano (Italian)
(1 BF3E (Japanese)
@) #20 (Korean)

() Espafiol (Spanish)

[ Cancel

|
Next >
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+3 COMSOL 44 Installer

H COMSOL

INSTALLER

Y% New COMSOL 4.4 Installation

KO

Add/Remove Features and Repair

Change License

E

Uninstall COMSOL 4.4

il

| <Back [ Cancel ]

2 In the COMSOL Installer, select one of the following options:

- Click New COMSOL 4.4 Installation and proceed to Step 3 (License Page) to
make a new installation.

- Click Add/Remove Features and Repair and proceed to Step 5 (Platform Page)
to change or repair an existing installation. For example, use Add/Remove
Features and Repair when adding or removing documentation files for
products installed or when adding or removing a product that your license
includes.

- Click Change License and proceed to Step 3 (License Page) to update the
license of an existing installation. Use this option when COMSOL is installed
and you get a new license file. The installer then removes features/products
not licensed any more and lets you go through the Add/Remove Features
procedure to add or remove features for the new license. If your trial license
has expired you can use the Change License option to re-enable a paid-for
license.

- Click Uninstall COMSOL 4.4 to remove an existing installation. For instructions
on this option, proceed to “Removing (Uninstalling) the COMSOL
Installation” on page 23.
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You can change the path to the existing installation by pressing the F1 key.

LICENSE PAGE

3 After selecting one of the four options, the following is displayed:

INSTALLER

Platforms Features Options Install  Finish

AH COMMSOL

COMSOL Software License Agreement

CAREFULLY READ THE TERMS AND CONDITIONS (HEREINAFTER, "TERMS AND CONDITIONS")
BELOW AND IN ANY APFLICABLE ADDENDUM BEFORE INSTALLING OR USING THE FROGRAMS
OR DOCUMENTATION. YOUR RIGHT TO USE ANY PROGRAMS AND DOCUMENTATION IS
CONDITIONED ON ACCEPTANCE OF, AND COMPLIANCE WITH, THESE TERMS AND CONDITIONS.
INSTALLING OR USING THE FROGRAMS MEANS YOU HAVE ACCEFTED THE TERMS AND
CONDITIONS. IF YOU DO NOT ACCEPFT THE TERMS AND CONDITIONS, RETURN THE PROGRAMS
AND RELATED MATERIAL UNUSED TO YOUR VENDOR FOR A REFUND OR CEASE ANY AND ALL
ATTEMETS TO DOWNLOAD AND INSTALL THE PROGRAMS AND DELETE ANY MATERIAL
DOWNLOADED.

s

(@ I accept the terms of the license agreement

() I do not accept the terms of the license agreement

License information

License format: :Passoode -
Passcode: FFFFFFFFFFFF-TYUS-123456-1234567-123456789
Name: My Name Company: My Company

[ <Back | [ TRexts

[ Cancel ]

After reading the license agreement, click the | accept the terms of the license
agreement button and specify the license. Use one of the following license

formats, depending on which license you have:

- Passcode: Use this option for a Single-User Trial License. Enter your
passcode, which is a series of characters and numbers that has a form similar
to FFFFFFFFFFFE-TYUS-123456-1234567-123456789. Note that the

passcode is case sensitive.

- License file: Use this option for any type of regular paid-for license installation.
Enter the path to an existing license file or click Browse to select the file
license.dat. This license file is sent to you by a COMSOL representative,

typically by email.

- Port number and Host Name: Use this option if your license administrator has
given you a port number and Host Name for a license manager for COMSOL
that is running somewhere on your organization’s network. Enter the Host
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Name of the computer or server running the license manager and its license

manager port number.

- Three-server redundancy: Use this option if your license administrator has
given you three port numbers and Host Names for the three-server
redundancy license manager option. Enter the Host Names and license server
port numbers of the three-server redundant configuration.

Change License

If Change License was sclected in Step 2, a menu in the upper-left area of the
Installer lets you choose to use an existing paid license, trial license, or you can

choose to specify a new license.

INSTALLER
Platforms Features Options Install Finish

License: |Specify new license -

+3 COMSOL 44 Installer

H COMSOL

COMSOL Socftware License Agreement

CAREFULLY READ THE TERMS AND CONDITIONS (HEREINAFTER, "TERMS AND CONDITIONS")
BELOW AND IN ANY APFLICABLE ADDENDUM BEFORE INSTALLING OR USING THE FROGRAMS
OR DOCUMENTATION. YOUR RIGHT TO USE ANY FROGRAMS AND DOCUMENTATION IS
CONDITIONED ON ACCEFTANCE OF, AND COMPLIANCE WITH, THESE TERMS AND CONDITIONS.
INSTALLING OR USING THE FROGRAMS MEANS YOU HAVE ACCEFTED THE TERMS AND
CONDITIONS. IF YOU DO NOT ACCEPT THE TERMS AND CONDITIONS, RETURN THE PROGRAMS
AND RELATED MATERIAL UNUSED TO YOUR VENDOR FOR A REFUND OR CEASE ANY AND ALL

@ I accept the terms of the license agreement

() I do not accept the terms of the license agreement

License information

License format: |Passcode -
Passcode: FFFFFFFFFFFF-TYUS-123456-1234567-123456789
Name: Company: My Company

[ < Back ][ Next > ]

[ Cancel ]

Click Next and proceed to Step 5 if you want to change to a license with different

products. Otherwise, proceed to Step 10.
4 Click Next.

PLATFORMS PAGE

5 On the Platforms page, you can typically accept the default settings. COMSOL
autodetects the type of operating system, which, for installation on Windows,
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can be Windows 32-bit or Windows 64-bit. On the 64-bit version of Windows
you can choose to install both versions.

COMSOL 4.4 INSTALLER ARCORASOL

Features Options Install Finish

Select platforms to install,

Windows (32-bit)
Windows (64-bit suppart, AMDE4/EME4T)

<Back | [ Mext> | [ cancel

6 Click Next.
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FEATURES PAGE

7 Select the features to install and specify the path to the COMSOL installation
folder.

*3 COMSOL 4.4 Installer

I “H COMSOL
INSTALLER
License  Platforms Options  Install  Finish
Quick selection: :Full installation -
-] 4 CoMSOL 4.4 »| Destination folder:
5 4 COMSOL Multiphysics | [Ct\Program Files\COMSOL\COMSCOLA4 |

=k COMSOL Multiphysics Documentation
ok COMSOL Multiphysics Models

=k AC/DC Module

=k Acoustics Module

ok Batteries & Fuel Cells Module

< CFD Module

-] =k Chemical Reaction Engineering Module
=k Corrosion Module

ok Electrochemistry Module

4 Electrodepasition Module

[k Heat Transfer Module

=k MEMS Module

-] 4k Microfiuidics Module

=+ Molecular Flow Module

=k Partide Tradng Module

-] 4k Pipe Flow Module

Feature description:

1,

Space required: 4217.9 MB
Free disk space: 96031.1MB

1

< Back ][ Next > I [ Cancel

Feature symbols:
— not currently installed, will be installed
— not currently installed, will not be installed
— currently installed, will not be updated
currently installed, will be updated

— currently installed, will be removed

X480 x+
|

If Change License was sclected earlier and you are changing the license of
an already existing installation, you need to pay attention to which check
boxes are selected. If you are adding products not previously part of your
installation, but added with the new license file, then you need to verify
the selection of the check boxes for the corresponding installation
components. (If you don’t, the license information is still correct but the
software components needed to run the products will be missing.)
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Add/Remove Features

If Add/Remove Features or Change License was sclected in Step 2, the Features page
includes a Repair all selected features check box. If this check box is selected, the
selected set of features determines which software components, documentation,
and models are to be added or removed. Features that are selected are added if not
previously installed, and features that are not selected are removed if previously
installed. The selected set only affects those products that you have licensed.

8 Click Next.

OPTIONS PAGE

*3 COMSOL 4.4 Installer ’;:E
AH COMMSOL
INSTALLER
License  Platforms  Features Install  Finish
Create COMSOL 4.4 shortcuts on Windows Desktop
Create COMSOL 4.4 folder on Windows Start Menu
Associate the .mph file type with this COMSOL 4.4 installation
Install DirectX runtime binaries
Check for updates after installation
[ Enable automatic check for updates
[] Install LiveLink for Excel for all users I
Proxy server: Hostname: my.proxy.com Port number: :ﬂ Username: Password:
LiveLink™ for MATLAB®
MATLAS installation root:
LiveLink™ for Pro/ENGINEER ®
Pro/ENGINEER installation rogt:
Example: C: les\PTC ts\Pros.0 s\proewildfire 5.0
LiveLink™ for Creo™ Parametric
Creo Common files folder:
Example: C:'\Program Files\PTC\Creo 1.0YComman Files'\FO00
< Back ] [ Next > I [ Cancel ]

9 Set the installation options:

Create COMSOL shortcuts on Windows Desktop
Create COMSOL folder in the Windows Start Menu
Associate the .mph file type with this COMSOL installation

If this check box is selected, you can open COMSOL models by
double-clicking them.

Install Microsoft DirectX® runtime binaries

Clear the Install DirectX runtime binaries check box if you previously
experienced problems using DirectX on your computer. DirectX can be used
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by COMSOL for accelerated graphics rendering. If you clear this check box,
then you still have two graphics options: OpenGL or software rendering.
Once installation is complete, you can change the graphics rendering method
from the Preferences dialog box on the Options menu in the COMSOL
Desktop.

For a Floating Network License, you can access COMSOL with a
Windows Remote Desktop connection. This way of accessing
COMSOL is only supported with the software rendering graphics
option.
- Check for updates after installation. This option is selected by default. The
installer then checks and applies all updates that are available for the version
that you install.

- Enable automatic updates after installation. Select this check box if you want
COMSOL to automatically check for and apply available software updates.

- Install LiveLink™ for Excel® for all users. If you select this check box, the
installation of LiveLink™ for Excel® is global to the machine and is available
no matter which user is logged on. Otherwise, the installation is only available
to the current user (this is the only supported option for Excel 2007).

- Ifyou install over the Internet using a proxy server, you can specify the host
name, port number, and, optionally, a username and password if required. If
you do not enter a port number, COMSOL uses port 443, which is the
default port setting for the HTTPS protocol. These settings do not appear if
you do not perform an installation via the Internet.

- For the LiveLink™ products for MATLAB®, Pro/ENGINEER®, and Creo
Parametric®, specify the path to their respective installation folders.

10 Click Next.
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INSTALL PAGE

Finish

COMSOL 4.4 INSTALLER

WH COMSOL

License  Platforms Features Options
AC/DC Module
AC/DC Module Documentation
AC/DC Module Models

Acoustics Module

Acoustics Module Documentation

Acoustics Module Models

Batteries & Fuel Cells Module

Batteries & Fuel Cells Module Documentation
Batteries & Fuel Cells Module Models

CAD Import Module

CAD Import Module Documentation

CAD Import Module Models

CFD Module

CFD Module Documentation

CFD Madule Models

COMSOL Cluster Components

COMSOL Multiphysics

COMSOL Multiphysics Documentation

COMSOL Multiphysics Models

Chemical Reaction Engineering Module

Chemical Reaction Engineering Module Documentatior
Chemical Reaction Engineering Module Models

< T ] »

-

-

[ <Bak ||

Tnstail | [ cancal |

Il When you click Install the utility now installs or updates COMSOL. The
installation process might take several minutes. A full installation including all
products typically takes more than 15 minutes to complete. If you are installing
over the internet, the installation time will depend on your internet connection
speed. The Finish page in Step 12 appears automatically when the installation

process is finished.
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FINISH PAGE
12 This window appears when the installation is finished.

13 COMSOL 4.4 Installer

| ) B COMSOL

INSTALLER

License Platforms Features Options  Install W=yl

The installation of COMSOL 4.4is finished.

The installation was successful.

Click Finish to quit the installer.

If warning or errors were detected, click View Log to open a window that shows
the installation log. Do not hesitate to contact technical support if you
encountered any errors and remember to send the installation log file along
with your technical support inquiry.

13 Click Finish to quit the installer.

For information on how to run COMSOL after installation, see “Running
COMSOL on Windows” on page 43. If you are installing on a Mac, see “Running
COMSOL on Mac OS X” on page 66. If you are installing on Linux, see
“Running COMSOL on Linux” on page 85.

Removing (Uninstalling) the COMSOL Installation

To remove a COMSOL installation from your system, you can uninstall using the
COMSOL Installer’s uninstallation option. The uninstaller deletes all old version
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COMSOL files and directories on the system that were installed by the COMSOL
installer. Additional files and folders created after installation are not removed.

If COMSOL is run with MATLAB, close MATLAB before starting the
uninstaller. If MATLAB is active, the utility cannot remove certain files.

You can start the COMSOL Uninstaller in a few different ways:

¢ From the Windows Start Menu, open the Control Panel and select Uninstall a
program. Find COMSOL 4.4 in the list and select Uninstall.

¢ From the Windows Start Menu under COMSOL 4.4, select Uninstall COMSOL
Multiphysics 4.4.

¢ Insert the COMSOL DVD and start the COMSOL Uninstaller. Click
Uninstall COMSOL 4.4 = to start removing the installation. Click Finish to quit
the installer when the uninstallation is complete.

e In Windows 8, go to the All apps page and click the COMSOL Launchers
folder. In that folder you find the Unistaller.

+3 COMSOL 4.4 Uninstaller

INSTALLER W CoMsaL

License Options Release Notes Platforms Features Options  Install Finish

This will remove all features installed by COMSOL 4.4,
Files and folders created after installation will not be removed.

Files and folders
Shortouts

Windows registry keys

i Uninstall 3 [ Cancel
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Installing Software Updates

COMSOL provides software updates that improve the software and correct issues.
To check if an update is available, choose Check For Updates from the Help menu.
If an update is available, an Update dialog box appears. Click Download to
download the update directly, or click Browse Update to open the COMSOL
website where you can read about and download the update. To check for updates
automatically each time you start COMSOL, select the Check for updates at launch
check box under Product updates on the Updates page in the Preferences dialog
box. When the update installation starts (close any running instance of COMSOL)
you see the following installation window:

+3 COMSOL 44 Installer

N COMSOL

INSTALLER

Release Notes  Install  Finish

Connection settings

() Download via proxy server

Host name: Port number: Username: Password:

[ Next > l [ Cancel ]

You can use a direct download (the default) or download via a proxy server. If you
download via a proxy server, specify the host name and port number for the proxy
and, if required, a username and password.

Automated Installation

You can install COMSOL using an automated installation process with minimal
user interaction. This method requires installation from a DVD or DVD image.
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An answer file then responds to questions while the installer is running. The
answer file is a text file with a specific format that contains predefined settings that
the COMSOL installer uses. Start the installation by running

<path to DVD>\setup.exe -s <answer file path>

where <answer file path> is the path to your answer file. A template answer
file, setupconfig.ini, with detailed usage information is available on the DVD.

AUTOMATED REMOVAL (UNINSTALLATION) oOF COMSOL

You can uninstall COMSOL using an answer file:
<path to COMSOL>\setup\setuplauncher.exe -s <answer Ffile path>

where <answer file path> is the path to your answer file.

Product Updates and Model Library Update

COMSOL periodically releases product updates with improvements and
corrections to reported problems. By default, COMSOL checks for updates at
startup. You can turn this feature on and off from the COMSOL Desktop
Preferences window. Here you can also configure settings for the Model Library
Update.

The COMSOL Model Library is updated on a regular basis by COMSOL. To
open the Model Library Update window from the File>Help menu (Windows
users) or from the Help menu (Mac and Linux users), select Update COMSOL
Model Library.
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This connects you to the COMSOL Model Library Update website where you can
access the latest models and model updates. This includes models that have been
added or improved since the latest product release.

General
User interface
Show [¥liCheck for updates at launch

Product updates

Expand sections
Model Builder
Cluster computing
Remote computing
Geometry
Graphics

Results Place Model Library Update files in
Builder Tools
Temporary files Destinaticns: [Currant model and documentation directories v l
Memory and processors
Updates

Livelink products

Proxy server settings for communication with COMSOL's Model Library Update server

Configuration: [ND proxy server A l

[ ok ][ cancel [ acpy |

_ ——

Using the Updates section in the Preferences dialog box you can configure proxy
server settings as well as model and documentation directories for the Model
Library Update. See the COMSOL Multiphysics Refevence Mannal for more
information, including command-line options for the Model Libraries.

LiveLink " for Excel® Installations

If you have licensed LiveLink™ for Excel®, several tools are accessible from a
COMSOL tab in the Excel ribbon for working with a COMSOL model from an
Excel worksheet. You can, for example, extract model definitions and results. You
can also change model definitions in the worksheet, then update and re-compute
the model.
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Whenever you open a COMSOL model from Excel, a COMSOL Server is started
where the model is loaded. The data transfer between Excel and the COMSOL
Server application is performed using a TCP/IP communication protocol, which
accepts only local connections.

LiveLink " for SolidWorks®: Add-In for SolidWorks

If you have licensed LiveLink™ for SolidWorks®, the COMSOL Installer registers
an add-in called the LiveLink for COMSOL (4.4). This add-in should appear in
the SolidWorks user interface, listed in the Add-Ins dialog box, accessible from the
Tools menu.

The add-in provides tools for preparing your SolidWorks design for simulation
with COMSOL. For example, you can create selections on the geometry and set
up dimensional parameters. Those selections and parameters, together with the
geometry, are synchronized with the COMSOL model.

The add-in enables two modes of setting up simulations based on the SolidWorks
design:

* In one mode you can run SolidWorks and the COMSOL Desktop
side-by-side and synchronize the geometry between the two.

e In another mode you can work with COMSOL simulations inside
SolidWorks. This latter mode is called the One-Window interface. Only one
version of the One-Window interface can be active at a time. If you have
several COMSOL versions installed, make sure that the latest version of
LiveLink for COMSOL is selected from the COMSOL>One-Window Version
menu inside SolidWorks. If required, restart SolidWorks after changing the
One-Window interface version.

If COMSOL cannot connect to SolidWorks, you can re-install COMSOL, or
follow the instructions from the following link:
http:/ /www.comsol.com/support/knowledgebase /1122.

LiveLink for Inventor®: Add-in for Autodesk Inventor

If you have licensed LiveLink™ for Inventor®, the installer registers an add-in for
Autodesk Inventor called the LiveLink for COMSOL (4.4). This add-in should
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appear in the Add-In Manager dialog box that is accessible from the Options tab
of the Tools panel in the Autodesk Inventor user interface.

The add-in provides tools for preparing your Inventor design for simulation with
COMSOL. For example, you can set up dimensional parameters that, together
with the geometry, are synchronized with the COMSOL model.

The add-in enables two modes of setting up simulations based on the Inventor
design:

¢ In one mode you can run Inventor and the COMSOL Desktop side-by-side
and synchronize the geometry between the two.

¢ In another mode you can work with COMSOL simulations inside Inventor.
This latter mode is called the One-Window interface.

If COMSOL cannot connect to Inventor, you can re-install COMSOL, or follow

the instructions from the following link:

http:/ /www.comsol.com/support/knowledgebase /1163.

LiveLink for AutoCAD® Installations

If you have licensed LiveLink™ for AutoCAD®, the installer registers an add-in
with AutoCAD called LiveLink for COMSOL (4.4). This add-in is loaded on
start-up of AutoCAD and provides functionality for synchronizing the geometry
between AutoCAD and COMSOL.

If you install a newer version of AutoCAD, and can no longer establish a
connection between the software, you can re-install COMSOL to register the
add-in with this new version of AutoCAD.

LiveLink™ for Pro/ENGINEER®: Changing the Installation
Path

If you have licensed LiveLink™ for Pro/ENGINEER®, you need to provide the
installation path for Pro/ENGINEER or Creo Elements/Pro during the install
process. The installer registers an add-in with Pro/ENGINEER called LiveLink
for COMSOL (4.4). The add-in should be listed in the Auxiliary Applications
dialog box that is accessible from the Tools menu in the Pro/ENGINEER user
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interface. The add-in provides functionality for selecting dimensional parameters
that can be synchronized with COMSOL.

After the installation you can configure the interface to work with a different
Pro/ENGINEER installation. Go to the Preferences window, which you can
access from the Options menu inside the COMSOL Desktop. There find the
LiveLink products section and edit the Pro/ENGINEER installation folder. It
should point to the root directory of the Pro/ENGINEER installation, typically

C:\Program Files\proeWildfire 5.0
or, for an installation of Creo Elements/Pro,

C:\Program Files\PTC\Creo Elements\Pro5.0
If you have installed both LiveLink for Pro/ENGINEER and LiveLink for Creo
Parametric, you can use only one of those during a COMSOL Multiphysics

modeling session. The default is to connect to Creo Parametric. To connect to
Pro/ENGINEER select LiveLink for Pro/ENGINEER from the Use list.

Restart COMSOL for the changes to take effect.

Note that changing the Pro/ENGINEER installation folder in the Preferences
window does not re-register the add-in with that Pro/ENGINEER installation.
To do this you can reinstall COMSOL, or follow the instructions from the
following links “Parameter Selection is not available in the Pro/ENGINEER user
interface”:

http:/ /www.comsol.com/support/knowledgebase /1159

If COMSOL cannot connect to Pro/ENGINEER Wildfire 4.0, follow the
instructions from the following link:

http:/ /www.comsol.com/support/knowledgebase /1162

LiveLink " for Creo ' Parametric: Changing the
Installation Path

Ifyou have licensed LiveLink™ for Creo™ Parametric, you need to provide the path
to the common files folder in the Creo Parametric installation during the
installation process. After the installation you can configure the interface to work
with a different Creo Parametric installation. To do so, go to the Preferences
window, which you can access from the Options menu inside the COMSOL
Desktop. There find the LiveLink products section and edit the Creo Parametric
common files folder. It should point to the common files directory of the Creo
Parametric installation, typically
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C:\Program Files\PTC\Creo 2.0\Common Files\M040
Restart COMSOL for the changes to take effect.

Note that changing the Creo Parametric common files folder in the Preferences
window does not re-register the add-in with that Creo Parametric installation. To
do this you can re-install COMSOL, or follow the instructions from the following
link:

http://www.comsol.com /support/knowledgebase /1158.

LiveLink " for Solid Edge®: Add-in for Solid Edge

If you have licensed LiveLink™ for Solid Edge®, the installer creates an add-in to
Solid Edge called LiveLink for COMSOL (4.4). This add-in should appear in the
Add-In Manager dialog box that is accessible in the Solid Edge user interface if
you click the Applications button, then select Add-Ins from the menu.

When the add-in is active a COMSOL Multiphysics tab appears in Solid Edge. Use
the Parameter Selection tool from the tab to select dimensional parameters that,
together with the geometry, are synchronized between Solid Edge and
COMSOL.

If COMSOL cannot connect to Solid Edge, you can re-install COMSOL, or
follow the instructions from the following link “Error: Failed to connect to Solid
Edge”:

http:/ /www.comsol.com /support/knowledgebase /1160

LiveLink " for SpaceCIaim®: Add-in for SpaceClaim

If you have licensed LiveLink™ for SpaceClaim®, the installer registers an add-in
with SpaceClaim called LiveLink for COMSOL (4.4). This add-in should appear
in the Add-Ins section of the SpaceClaim Options dialog box that is accessible in
the SpaceClaim user interface if you click the button for the Applications menu.

When the add-in is active you synchronize the geometry and any driving
dimensions that are defined on the geometry between SpaceClaim and COMSOL.
If COMSOL cannot connect to SpaceClaim, you can reinstall COMSOL, or
follow the instructions from the following link “Error: Failed to connect to
SpaceClaim”:
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http:/ /www.comsol.com/support/knowledgebase /1164

Cluster Installation

COMSOL supports two mutual modes of parallel operation: shared-memory
parallel operations and distributed-memory parallel operations, including cluster
support. This section is dedicated to distributed-memory parallel installation.
COMSOL can distribute computations on compute clusters using the MPI
model. One large problem can be distributed across many compute nodes. Also,
parametric sweeps can be distributed with individual parameter cases distributed
to each cluster node.

LICENSE MANAGER

COMSOL requires a Floating Network License for running on clusters. Please
check the license file for the CLUSTERNODE feature, which needs to be present
to enable the cluster computing functionality. The license manager needs to be
accessible from all nodes in the cluster. Therefore it is often a good idea to have it
run on the head node.

INSTALLATION FOLDER

The COMSOL installation folder should be shared between all compute nodes
and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.

ACCESS TO CLUSTER (WINDOWS HPC SERVER ONLY)

If you work on a desktop PC, install COMSOL on that PC. Before you start, you
need to install Windows HPC Pack on the PC. This software is free and shipped
with the Windows Server operating system and enables you to access the cluster
from your PC.

For more information on installing and running COMSOL on clusters, see
“Running COMSOL on Clusters” on page 50 and the COMSOL Multiphysics
Reference Manual.
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License Manager Installation on Windows

Depending on your region and operating system, you might be required to install
and run the FlexNet license manager software in order to run COMSOL.

What is the FlexNet® License Manager?

COMSOL uses the FlexNet license manager version 11 from Flexera Software,
Inc. for license management. (FlexNet was formerly called FLEXIm™.)

The license manager comes bundled with any COMSOL installation. The
COMSOL software products and the license manager can be installed in any
order, unless you are installing based on a port number and Host Name. In that
case, the license manager software needs to be installed and started before
installing COMSOL.

Installation of any paid-for license on Windows requires a license file
(license.dat), which is sent to you by a COMSOL representative by email. You
can view the contents of the license file by opening it with a text editor or word
processing software. If the file contains a line starting with the word SERVER,
then the FlexNet license manager is required. For a Floating Network License, the
purpose of the license manager software is to count the number of concurrent
users and to give an error message if the number exceeds the licensed number of
concurrent users. Depending on your region and operating system, the license
manager software might also be needed for Single User Licenses. In that case, the
purpose of the license manager software is to lock a COMSOL session to a
computer that is authorized by COMSOL.

The FlexNet license manager supports a heterogeneous network of Windows,
Linux, and Mac OS X computers. Both the license manager and the COMSOL
software can run on either Windows, Linux, or Mac platforms. In this context, the
computer where the license manager is installed is called the license server and any
computer that has the COMSOL products installed is called a client. Any type of
computer can function as a license server, such as a laptop, desktop, workstation
or a centrally located server. COMSOL can be installed anywhere, typically on a
local PC or on a file server where users access the program over a network. A single
computer can function as both license server and client, holding both the license
manager and COMSOL.

Even though the license manager and COMSOL can be installed in any order, a
full test of the installation cannot be done until both are installed.
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System Requirements for the FlexNet® License Manager

Before starting the installation process, check that your system meets all necessary
requirements as listed at: www.comsol.com/system-requirements. For
COMSOL, all requirements need to be met. If you are running the license
manager on a license server where you did not intend to run COMSOL, the
system requirements are less stringent. The license server only needs to meet the
listed hardware and operating system requirements. For the license manager,
memory and graphics requirements do not need to be met. The license manager
is a much less CPU- and memory-demanding application than COMSOL.

FlexNet® License Manager Software Components

The license manager consists of four software components:
e License manager daemon (1lmgrd.exe)

e Vendor daemon (LMCOMSOL . exe)

e FlexNet utility program (1mutil.exe)

¢ FlexNet Control Panel (1mtools.exe)

The two daemons (1mgrd. exe and LMCOMSOL . exe) run on the license server. When
a user starts COMSOL on a client computer, communication is established
through the network from the client to the license server and the license manager
daemon (1mgrd.exe). That daemon in turn makes a request to the vendor daemon
(LmcomsoL . exe), which releases licenses according to information in the
license.dat file. The FlexNet utility program and FlexNet Control Panel are used
for handling license server management tasks.

FlexNet® License Manager Documentation

For detailed information on the FlexNet license manager software, click the
button and choose Help>Documentation (Windows) or select
Help>Documentation (Mac and Linux). Then scroll to the bottom of the page to
locate a PDF copy of the FlexNet License Administration Guide for FlexNet
Publisher. You can also find the FlexNet documentation on your hard drive. The
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default folder location is C: \Program
Files\COMSOL\COMSOL44\doc\pdf\comsol\flexnet

The License File

The license file has the same structure on all platforms: Windows, Mac OS X, and
Linux. In this section, the most important parts of the license file are explained.
Below is an example of the contents of a 1icense.dat file:

# COMSOL 4.4 FNL License No: 1234567
# Visit www.comsol.com/install for latest installation instructions

SERVER apollo.thecompany.com 0050569e1b87 1718

USE_SERVER

VENDOR LMCOMSOL port=1719

FEATURE SERIAL LMCOMSOL 4.32 permanent uncounted \
VENDOR_STRING=C,5701108 HOSTID=ANY BORROW=720 SN=1234567 TS_OK \
SIGN=0C3A8BF6722E

INCREMENT COMSOL LMCOMSOL 4.32 permanent 4 SUPERSEDE DUP_GROUP=UHD \
ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC

INCREMENT COMSOLGUI LMCOMSOL 4.32 permanent 4 SUPERSEDE DUP_GROUP=UHD \
ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC

INCREMENT HEATTRANSFER LMCOMSOL 4.32 permanent 2 SUPERSEDE \
DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
SIGN=123456789ABC

INCREMENT CLIENTSERVER LMCOMSOL 4.32 permanent 4 SUPERSEDE \
DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
SIGN=123456789ABC

INCREMENT CLUSTERNODE LMCOMSOL 4.32 permanent 4 SUPERSEDE DUP_GROUP=U \
ISSUED=6-JUN-2012 BORROW=720 SN=1234567 SIGN=123456789ABC

INCREMENT COMSOLBATCH LMCOMSOL 4.32 permanent 2 SUPERSEDE \
DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
SIGN=123456789ABC

INCREMENT HEATTRANSFERBATCH LMCOMSOL 4.32 permanent 2 SUPERSEDE \
DUP_GROUP=UHD ISSUED=6-JUN-2012 BORROW=720 SN=1234567 \
SIGN=123456789ABC

THE COMMENT LINES

Comment lines can be included in the license file by starting them with the hash
symbol #. These lines have no effect on the license server or client.
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THE SERVER LINE

In the license.dat file, the contents of the line starting with SERVER should
contain:

e The Host Name of the license server. In the example above, the Host Name
is apollo.thecompany.com. This name can be edited by the user.

e The hostid of the license server. In the example above, the hostid is
0050569e10b87. This number cannot be edited by the user.

e A port number. In the example above, the port number is 1718.This
number can be edited by the user.

Confirm that the license server Host Name is the actual name of your license server
(the computer that you intend to run the FlexNet license manager software on);
otherwise, change it by editing the file. The default port number (1718) can be
changed in the unlikely event that another program is already using that port
number (you then get an error message indicating this when starting the license
manager). If the default port number 1718 is being used, change it to any other
number between 1025 and 64,000.

THE USE_SERVER LINE

The USE_SERVER line, with no arguments, does not impact the license manager
but has implications for the client. When a COMSOL client sees the
USE_SERVER line, it ignores everything in the license file except the preceding
SERVER lines and transfers checkout validation to the vendor daemon. This
means that if you are running COMSOL on one computer, and the license
manager on a different computer, then your license file can only contain two lines:
the SERVER line and the USE_SERVER line.

THE VENDOR LINE

The VENDOR line defines the name of the LMCOMSOL vendor daemon. This
name cannot be changed. The vendor daemon is a process that has to be running
together with the license manager and is automatically started when the license
manager is started. The LMCOMSOL vendor daecmon requires its own port
number. In the example above, the default port number 1719 is shown.

If the license manager is running on a computer with an active firewall and the
COMSOL client is outside of that firewall, at least two port numbers must be
opened up in the license server’s firewall to allow client computers to connect to
the license manager and the vendor daemon.

Using the example license file above, configure the firewall to allow access to the
port numbers 1718 and 1719. If you have chosen other port numbers and
modified the 1icense.dat file accordingly, configure the firewall to allow access
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to your chosen port numbers. If you are unsure about which port numbers are free
or how to enable firewall port access, contact your system administrator.

You cannot modify anything in the license.dat file except the license server name
and (if necessary) port numbers, or the license might not work.

THE SERIAL LINE

The SERIAL line contains information on the license type, license number, and
the products included in the license.

THE INCREMENT AND FEATURE LINES

The INCREMENT or FEATURE lines contain a product name, version,
expiration date, and the number of available licenses. The example file above
shows that the user has a perpetual (permanent) COMSOL 4.4 Floating Network
License allowing four concurrent users of COMSOL Multiphysics and two
concurrent users of the Heat Transfer Module. The number after “SIGN=""at the
end of each INCREMENT line contains a license key. Long lines can be broken
by a continuation character (\).

The Feature Names

The following table contains the FEATURE names for all products in the
COMSOL 4.4 product suite:

PRODUCT/FEATURE FEATURE NAME

COMSOL Multiphysics comMsoL

COMSOL Multiphysics GUI COMSOLGUI

COMSOL Muttiphysics Floating Network License  CLIENTSERVER, CLUSTERNODE
AC/DC Module ACDC

Acoustics Module ACOUSTICS

Batteries & Fuel Cells Module BATTERIESANDFUELCELLS
CAD Import Module CADIMPORT, CADREADER
CFD Module CFD

Chemical Reaction Engineering Module CHEM

Corrosion Module CORROSION

ECAD Import Module ECADIMPORT
Electrochemistry Module ELECTROCHEMISTRY
Electrodeposition Module ELECTRODEPOSITION
Fatigue Module FATIGUE
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PRODUCT/FEATURE

FEATURE NAME

File Import for CATIA V5
Geomechanics Module

Heat Transfer Module
LiveLink™ for AutoCAD®
LiveLink™ for Creo™ Parametric
LiveLink™ for Excel®
LiveLink™ for Inventor®
LiveLink™ for MATLAB®
LiveLink™ for Pro/ENGINEER®
LiveLink™ for Solid Edge®
LiveLink™ for SolidWorks®
LiveLink™ for SpaceClaim®
MEMS Module

Mixer Module

Molecular Flow Module
Muttibody Dynamics Module
Nonlinear Structural Materials Module
Optimization Module

Particle Tracing Module

Pipe Flow Module

Plasma Module

RF Module

Semiconductor Module
Structural Mechanics Module
Subsurface Flow Module
Wave Optics Module

CATIA5
GEOMECHANICS
HEATTRANSFER
LLAUTOCAD
LLCREOPARAMETRIC
LLEXCEL
LLINVENTOR
LLMATLAB
LLPROENGINEER
LLSOLIDEDGE
LLSOLIDWORKS
LLSPACECLAIM

MEMS

MIXER
MOLECULARFLOW
MULTIBODYDYNAMICS
NONLINEARSTRUCTMATERIALS
OPTIMIZATION
PARTICLETRACING
PIPEFLOW

PLASMA

RF

SEMICONDUCTOR
STRUCTURALMECHANICS
SUBSURFACEFLOW
WAVEOPTICS

Installing the License Manager

The FlexNet license manager is automatically installed when installing COMSOL
unless otherwise specified on the Features page of the COMSOL Installer; see
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“Features Page” on page 19. The check box for the license manager components
can be found last in the list of software components, as seen in the picture below:

+3 COMSOL 4.4 Install

INSTALLER T coMsaL

License Platforms QS==il=- Options Install Finish

Quick selection: [Full installation -]

- Destination folder:
- [w] o Structural Mechanics Module
=k Subsurface Flow Module
= Wave Optics Module Feature description:
=k CAD Import Module
=k ECAD Import Module
- [w] ok Livelink™ for AutoCADE
- [w] ok Livelink™ for Creo™ Parametric
o LiveLlink™ for Excel®
=k Livelink™ for Inventor®
ok Livelink™ for MATLAB®
=k Livelink™ for Pro/ENGINEER®
=k Livelink™ for Solid Edge®
=k LiveLink™ for SolidWorks®
o= Livelink™ for SpaceClaim@ E
=k Optimization Module
= Material Library
.. =k COMSOL Cluster Components

i WO O O O O O O O O O O O O O B

)
)
)
)
)
)
)
)
)
)
)
)
)
)
)
)

Space required: 4237.4MB
- [ 4 License Manager - Free disk space: 95808.3 MB

[ < Back ][ Mext > ] [ Cancel ]

If you do not intend to run the license manager software on the computer for
which you are installing COMSOL, you can clear this check box during
installation. The license manager components require a moderate amount of hard
disk space (about 26MB).

Ifyou want to install COMSOL on the same computer as the license manager, first
perform a complete COMSOL installation including the license manager software
components. When finished, skip the remainder of this section and continue with
“Starting the License Manager” on page 40.

To install only the license manager, follow the installation instructions for
COMSOL earlier in this document and on the Features page and clear all check
boxes except the one for the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation
process with minimal user interaction; see “Automated Installation” on page 25.
Set licmanager = 1 in the answer file to install the license manager.
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Starting the License Manager

The license manager can be started manually, or it can be configured to run
automatically as a service each time the license server is restarted.

STARTING THE MANAGER AUTOMATICALLY AS A SERVICE

To set up the license manager as a service from the FlexNet Control Panel
(LMTOOLS):

I Locate the COMSOL44\1license\win32 (Windows 32-bit) or
COMSOL44\license\win64 (Windows 64-bit) folder and run 1mtools.exe.
Alternatively, run LMTOOLS from the Windows Start menu, available under
COMSOL 4.4>License Tools>LMTOOLS.

2 On the Service/License File page choose Configuration using Services.

3 Click the Configure Services tab.

-
LMTOOLS by Macrovision Corperation hﬂp:ﬂwww.macmvisiun.mrr- =)

File Edit Mode Help

Service/License Fl\e] System Settlngsl Utlhllesl Slarthlup.r‘Heread} ServerStalus] Server Diags  Config Services ]Bunuwmg}

Save Service
Remove Service

Configure Service

Service Name [COMSOL License Manager |

Path to the Imgrd.exe file ‘ED MSOLACOMSOL4dicense winbd\mard. exe M

Pathta the license fle | FilestCOMSOLACOMSOL44 icensehlicense. dat M

Path ta the debug log file ‘ES\EUMSUL\EUMSUL44\|\CEHSE\CDI‘HSU‘44\Ug Browse | Wiew Log | ‘

- I Use Services

4 Make an entry in the Service Name ficld, for example, COMSOL License
Manager.

5 Specify the full paths to 1mgrd.exe and license.dat by browsing to their
locations on your hard drive. The default location for 1mgrd.exe is C:\Program
Files\COMSOL\COMSOL44\1license\win64\1lmgrd.exe, and for the license file, it is
C:\Program Files\COMSOL\COMSOL44\license\license.dat. For the debug log
file, you can use any name of your choice, for example, comso144.1og. For
convenience you can place this next to your license file at: C:\Program
Files\COMSOL\COMSOL44\1license\comsol44.1log.
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Make sure your Windows user account has read /write permission for the

folder of the debug log file, otherwise the debug log file is not created.

6clect the Use Services check box (this might not be possible on all
platforms, but it is reccommended when available) and then the Start Server at
Power Up check box.

7 Click Save Service. The license manager now starts at automatically when you
reboot the license server computer. If you want to start the license manager
right away without restarting the license server computer, click Start Server on
the Start/Stop/Reread page of the FlexNet Control Panel.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, browse to the license\win32 (Windows
32-bit) or license\win64 (Windows 64-bit) folder. Now, in a Windows command
window enter

Imgrd -c ..\license.dat -1 ..\comsol44.log

The license manager is now ready to distribute licenses over the network. It writes
debug information to the log file COMSOL44\license\comsol44.log.

Verifying that the License Manager is Running

Once you start the license manager, it is good practice to verify that the license
manager service is running. Start the Windows Task Manager and go to the
Services page. Check that the COMSOL License Manager service is running.

Starting COMSOL

After the installation is complete and the license manager daemons are running on
the license server, you can start using COMSOL. For more information on how
to run COMSOL, see “Running COMSOL on Windows” on page 43.
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Changing the License

If you have received a new license file—for example, when adding COMSOL
products to an existing license—replace the current license file with the new one.
Double-check the contents of this file to make sure it lists the products that the
license includes. See also “The Feature Names” on page 37.
When the license file has changed, you must restart the license manager;
otherwise, it continues to use the old license file still in memory.

RESTARTING THE LICENSE MANAGER
To restart the license manager, follow these steps:
I In the Windows Start menu, choose COMSOL4.4>License Tools>LMTOOLS.

2 In the FlexNet Control Panel, click, in this order, Stop Server, Reread License
File, and Start Server.

OBTAINING A HOSTID
If you need to verify the hostid of the license server, you can follow the steps for
“Obtaining the Hostid” on page 8. Alternatively, if COMSOL is already installed
on the license server, you can determine the hostid by running the 1mhostid
command

COMSOL44/1icense/win32/1mutil lmhostid

or
COMSOL44/1icense/win64/1mutil lmhostid

for Windows 32-bit and Windows 64-bit, respectively.

The hostid is typically the Ethernet address (also called a MAC address) of the

network card of your computer. An Ethernet address has six bytes, each with two

hexadecimal digits. Thus, the full hostid has twelve hexadecimal digits.

Alternatively, the hostid can be the volume serial number of your C hard drive.

The volume serial number has 4 bytes, each with two hexadecimal digits. In this

case, the full hostid has eight hexadecimal digits.

Troubleshooting License Errors

If you have questions or problems with your installation, see “Troubleshooting
License Errors” on page 91.
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Running COMSOL on Windows

After the installation is finished there is a COMSOL Multiphysics 4.4 shortcut
icon on the Windows desktop:

as well asa COMSOL 4 .4 folder on the Windows Start menu. To start COMSOL,
double-click the desktop icon or select COMSOL Multiphysics 4.4 from the
Windows Start menu. For Windows 8 instructions, see “Running COMSOL on
Windows® 8” on page 44.

CROSS-PLATFORM USER INTERFACE

The default user interface for COMSOL is a Windows application. There is also a
cross-platform user interface that you can start by going to the bin\win32 (32
bit) or bin\win64 (64 bit) folder in the COMSOL installation directory and
double-clicking comsolxpl.exe. The cross-platform user interface is identical to
the interface on Linux and the Mac.

The COMSOL Folder on The Windows Start Menu

Depending on which COMSOL products and software components you have
licensed and installed, the COMSOL 4.4 folder on the Start menu contains a
selection of the items in the following list:

e COMSOL Multiphysics 4.4: Starts the COMSOL Desktop.

* Model Animations: Launches a web browser with a selection of model
animations at: www.comsol.com/showroom /animations

e Uninstall COMSOL Multiphysics 4.4: Starts the COMSOL Uninstaller. For
more information, see “Removing (Uninstalling) the COMSOL Installation”
on page 23.

e 32-bit: Contains COMSOL 32-bit executables
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e Client Server

- COMSOL Multiphysics 4.4 Client: Starts a COMSOL Client that can be
connected to a COMSOL Server.

- COMSOL Multiphysics 4.4 Server: Starts a COMSOL Server that a
COMSOL Client can connect to.

For more information on running COMSOL in client-server mode, see
“Running COMSOL in Client-Server Mode” on page 47.

e COMSOL with MATLAB: This is available if you have licensed the Live Link
for MATLAB®. It starts MATLAB and sets up all necessary paths. It also starts
a COMSOL Server connected to MATLAB. See also “Running COMSOL
with MATLAB” on page 52.

* Documentation: Opens a folder that contains COMSOL documentation
shortcuts.

e License Tools: Starts the FlexNet license manager control panel
(LMTOOLS). For more information, see “License Manager Installation on
Windows” on page 33.

Running COMSOL on Windows® 8

On Windows 8, COMSOL can be started from three different locations:
® There is a COMSOL Multiphysics tile on the Windows Start Screen:

|

COMSOL
Multiphysics 4.4
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® There are two icons on the Window Desktop for COMSOL Multiphysics
and COMSOL Help Desk:

COMSOEA4
Help'Desk

* The Windows All apps page has three tiles for COMSOL Help Desk,
COMSOL Launchers, and COMSOL Multiphysics:

COMSOL Help
Desk

COMSOL
Launchers

COMSOL
Multiphysics 4.4

Starting COMSOL for a Classkit License

If you have a Classkit License, you start it by double clicking its dedicated
Windows desktop icon:

Multiphysics

For Windows 8, corresponding tiles and desktop icons are added.

Running COMSOL on Windows | 45



Creating Desktop Shortcuts Manually

Sometimes it is necessary to create the COMSOL shortcuts manually, for example,
when COMSOL is installed on a shared network drive.
I Locate the COMSOL executable. Its default location is

C:\Program Files\COMSOL\COMSOL44\bin\win64\comsol.exe

or
C:\Program Files\COMSOL\COMSOL44\bin\win32\comsol.exe

for Windows 64-bit and Windows 32-bit, respectively

2 Right-click comsol.exe and select Create shortcut, which creates a shortcut
with a default name comsol.exe - Shortcut. If this shortcut is not created on the
Desktop, then move it there by drag-and-drop.

CREATING A DESKTOP SHORTCUT MANUALLY FOR THE CROSS-PLATFORM
USER INTERFACE
The cross-platform user interface for COMSOL that is available on Mac and Linux
has a slightly different look-and-feel than the user interface for Windows. You can
get access to the cross-platform user interface from

C:\Program Files\COMSOL\COMSOL44\bin\win64\comsolxpl.exe

assuming that you are running the 64-bit version and that the default installation
location has not changed by you during installation.

To create a shortcut to the cross-platform user interface, right-click comsolxpl.exe and
select Create shortcut, which creates a shortcut with a default name comsolxpl.exe -
Shortcut. If this shortcut is not created on the Desktop, then move it there by
drag-and-drop.

CREATING DESKTOP SHORTCUTS MANUALLY FOR A CLASSKIT LICENSE

If you manually create a desktop shortcut for a Classkit License, then, in addition
to the steps above, the shortcut’s Target needs to be modified with additional
options. Right-click the COMSOL shortcut icon and select Properties. Change the
text string in the Target field to

"C:\Program Files\COMSOL\COMSOL44\bin\win64\comsol.exe" -Dcs.ckl
"C:\Program Files\COMSOL\COMSOL44\bin\win64\comsolclasskit.ini"

(The complete text string must be written on a single row.)
or

"C:\Program Files\COMSOL\COMSOL44\bin\win32\comsol.exe" -Dcs.ckl
"C:\Program Files\COMSOL\COMSOL44\bin\win32\comsolclasskit.ini"
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for Windows 64-bit and Windows 32-bit, respectively.

Here, C:\Program Files\COMSOL\COMSOL44 represents the default COMSOL
installation directory and this can be changed in the Target field text string if your
installation is placed in a different folder.

Running COMSOL in Client-Server Mode

When you start COMSOL by, for example, double-clicking the Windows desktop
icon, COMSOL is run as a single application that includes both the COMSOL
Client and COMSOL Server, as explained later in this section. However, the
COMSOL Client/Server architecture lets you access the COMSOL Server—the
COMSOL computational engine—as a separate process. For example, the
COMSOL Desktop can act asa COMSOL Client when connected toa COMSOL
Server.

The license server is not the same as a COMSOL Server. The license
manager can run on a computer different from both the ones used by
COMSOL Desktop and COMSOL Server.

You need a Floating Network License to run the COMSOL Server and the
COMSOL Client on separate computers. However, any COMSOL license is
sufficient for running the Client and the Server on the same computer.

The Client and Server need not run on the same platform. For example, you can
run the COMSOL Desktop on Windows connecting to a COMSOL Server on a
Linux or Mac computer. This enables offloading heavy-duty computations from
your personal laptop or desktop to run just the COMSOL Desktop graphical user
interface. A typical use would be to run the COMSOL Server on a computer with
large amounts of memory (RAM) and processing power and to use your personal
computer for pre- and postprocessing with the COMSOL Desktop.

STARTING A COMSOL SERVER

The COMSOL server is a single user server allowing multiple sessions by the same
user, one session at a time. To start the COMSOL Server, click COMSOL
Multiphysics Server in the Client Server folder underneath your COMSOL folder
on the Windows Start menu. (On Windows 8 you find this on the All apps page
under COMSOL Launchers.) When you start the COMSOL Server from the
Windows Start menu, a command window appears asking you for a username and
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password. You can use any username and password of your choice, it is only used
for connecting a COMSOL Client with a COMSOL Server.

| COMSOL Multiphysics 4.4

COMSOL 4.4 {snapshot? {Build: 96> started listening on port 2836
Use the console command ‘close’ to exit the program

When the COMSOL Server starts, it listens for a COMSOL Client connection on
the port listed in the command window. In the example above it is port 2036.

CONNECTING A COMSOL cLIENT TO A COMSOL SERVER

You can start a COMSOL Client session by clicking COMSOL Multiphysics
Client in the Client Server folder underneath your COMSOL folder on the
Windows Start menu. (On Windows 8 you find this on the All apps page under
COMSOL Launchers.) You can also connect to a COMSOL server from the
COMSOL Desktop by selecting Connect to Server from the File menu. When you
start the Client, a Connect to Server window appears prompting you for a
computer name (Server) where the COMSOL Server is running, Port number,
Username, and Password.

Server

User
Server:  localhost Usemame: | paul

Port: |DEfauIt = | Password: eesssssssssss

| Remember password

| OK | | Cancel ‘

Once you have filled out this information and clicked OK, the COMSOL Server
command window indicates that a COMSOL Client has connected. For more
information on running COMSOL in Client/Server mode, see the COMSOL
Multiphysics Refevence Manual.
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Running COMSOL in Batch Mode

You can submit COMSOL batch jobs from the COMSOL Desktop and the
command line. To run a COMSOL batch job, you need to make the Batch feature
visible: in the Model Builder tree, click the Show button (*& ) and select Advanced
Study Options. In the Model Builder, right-click a Study node and select Batch to
create batch jobs. From the Windows command window, you can start batch jobs
using the comsolbatch command. This is an example of how such a command
could look like:

comsolbatch -inputfile in.mph -outputfile out.mph
To run a specific study add the command line option -study <tag>, where <tag>
is the tag of the study to run, for instance, std1. To see the tag, select Model

Builder Node Label>Show Name and Tag in the COMSOL Desktop (on the Home
toolbar in Windows, or from the Windows menu in Linux and Mac).

The COMSOL Multiphysics Reference Manual has a dedicated section on
running COMSOL from the Windows command window, including a list of
COMSOL commands and associated syntax.

Running COMSOL on Multicore Computers

COMSOL supports two modes of parallel operation: shared-memory parallel
operations and distributed-memory parallel operations, including cluster support.
This section covers shared-memory processing, or multithreading, which is
important for the performance of COMSOL computations. Some terms that are
frequently used when describing multithreading are:

e Core: The core is a processor core used in shared-memory parallelism by a
computational node with multiple processors.

o Speedup is how many times faster a job runs on N cores compared to 1 core,
on a specific compute node. The speedup depends on the simulation type,
the hardware used, and hardware drivers used.

In Windows, the default number of processor cores used by COMSOL is the total
number of available physical cores. For example, if you have a 2 x dual core
machine, 4 cores are used in parallel by a COMSOL process.

Here is how to find out how many processor cores your Windows machine has
(applicable for computers that do not have Intel® Hyper-Threading Technology
and AMD® computers that are not based on Bulldozer):
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I In the Windows file browser, right-click Computer or My Computer, sclect
Properties.

2 Click Advanced system settings. Go to the Advanced tab.
3 Click the Environment Variables button and look in the System variables list.
Look for NUMBER_OF_PROCESSORS and check its value. This is actually

the number of cores. If you have two processors with 2 cores each, this number
is 4. Alternatively, start a Windows command window and type

echo %NUMBER_OF_PROCESSORS®%

If you want COMSOL to leave out one or more processor cores you can set the
number of cores used for a computational job in the Preferences dialog box under
Memory and processors (by first selecting the Number of processors check box
and then entering the number of processor cores to use).

You can also change the default behavior of COMSOL by setting the environment
variable COMSOL_NUM_THREADS to the desired number of cores. See the COMSOL
Multiphysics Refevence Manual for more information.

Running COMSOL on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the
command line. To run COMSOL on a cluster, you need to make the cluster
features visible: in the Model Builder tree, click the Show button (& ) and select
Advanced Study Options. Then in the Model Builder, right-click a Study node
and select Cluster Computing or Cluster Sweep to create cluster jobs. Cluster
computing requires a Floating Network License.

The following terms occur frequently when describing the hardware for cluster
computing and shared-memory parallel computing:

e Compute node: The compute nodes are where the distributed computing
occurs. Each distributed COMSOL process resides in a compute node and
communicates with other compute nodes using MPI (message-passing
interface).

e Host: The host is a physical machine (hardware) with a network adapter and
unique network address. The host is part of the cluster. It is sometimes
referred to as a physical node.

e Core: The core is a processor core used in shared-memory parallelism by a
computational node with multiple processors.

50 | Running COMSOL on Windows



The number of used hosts and the number of computational nodes are usually the
same. For some special problem types, like very small problems with many
parameters, it might be beneficial to use more than one computational node on
one host.

A tutorial model for cluster testing is included in the Model Libraries window
under COMSOL Multiphysics>Tutorial models>micromixer_cluster

QUICK TROUBLESHOOTING

* Your first step is to make sure you have the latest release installed. Check that
you have COMSOL 4.4 or later. Also make sure to install the latest product
updates.

* For Windows HPCS, log in to each node with remote desktop and start the
COMSOL Desktop GUI. No error messages should be displayed.

¢ Ifyou get the error message “Process status indicates that process is
running,” then cancel any running jobs in the Windows HPCS Job manager
or other scheduler that you use. In the COMSOL Desktop, locate the
External Process page at the bottom right. Click the Clear Status button.

For more information about how to run COMSOL in parallel on Windows
clusters, see the COMSOL Multiphysics Refevence Manual. For installation on
Clusters, see “Cluster Installation” on page 32.

Running COMSOL on the Cloud

COMSOL supports cloud computing using Linux through Amazon Elastic
Compute Cloud™ (Amazon EC2)™. See the PDF version of Running COMSOL
on the Amazon™ Cloud for further information: www.comsol.com /ec2_manual.
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Running COMSOL with MATLAB

Running COMSOL with MATLAB requires a LiveLink™ for MATLAB® license.
To run COMSOL with MATLAB, double-click the COMSOL Multiphysics 4.4
with MATLAB icon on the desktop.

2

COMSOL

Alternatively, start COMSOL with MATLAB from the Start menu by pointing to
Programs, then to COMSOL 4 .4, and then select COMSOL Multiphysics 4.4
with MATLAB. For Windows 8, corresponding tiles and desktop icons are added,
and you can click COMSOL Multiphysics 4.4 with MATLAB on the start screen
to launch COMSOL.

Running COMSOL with MATLAB starts a COMSOL Server and a MATLAB
Desktop. The COMSOL Desktop is not involved. You can change the path to the
MATLARB installation in the Preferences window accessed from the Options menu
of the COMSOL Desktop. For more information, see the LiveLink™

for MATLAB® documentation.

STARTING COMSOL wITH MATLAB USING THE GRAPHICS SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL
with MATLAB using the graphics server. To do so, append the flag -graphics
to the COMSOL with MATLAB target path.
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Installing on Mac OS X

Installation Over the Internet

INSTALLATION OF A TRIAL LICENSE OVER THE INTERNET

A trial license can be given to you with the intention to test the software without
any payment obligation for noncommercial and nonproduction use. This option
is not available in all regions.

Installation of a Single User Trial License on Mac requires a license passcode. A
passcode has a form similar to:

FFFFFFFF-TYUS-123456-1234567-123456789

This is usually sent to you by your COMSOL representative by email. Once you
locate your passcode, follow these steps to prepare for download and installation:

I Click the link for downloading the software as given in the software download
email from your COMSOL representative. This link is identical or similar to:
www.comsol.com/support/download /trial.

2 If you haven’t already created a COMSOL Access account, you will be
prompted to create it. While creating the account, enter your trial passcode to
associate it with your account information.

If you already have created a COMSOL Access account, then the link
www.comsol.com /support/download /trial directs you to a page where you
can enter the passcode:

3 Follow the web-based instructions to download the software.

4 Continue with the instructions in the section “Downloading the COMSOL
Installer” on page 56.

INSTALLATION OF A PAID-FOR LICENSE OVER THE INTERNET

Installation of any paid-for license on Mac requires a license file that is sent to you
by your COMSOL representative by email. To be able to generate the license file,
information about your hardware is needed in the form of a hostid (host ID). The
hostid is used to lock the license to your hardware and needs to be sent by you to
a COMSOL representative prior to the license file being generated.
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Obtaining the Hostid

Follow these steps to obtain a hostid:

I Launch the application Network Utility found in the Applications/Utilities folder.
2 Click the Info tab to the left.

3 Select Network Interface (en0). This corresponds to your Ethernet card.

4

The hostid is the Hardware Address—as shown in the figure below, but with
the colons (:) removed. If you plan to install on a computer with a wireless
network card, report the hardware address for both Network Interface (en0)
and Network Interface (enl).

806 Network Utility

'_ Info- | Netstat = AppleTalk | Ping Lookup = Traceroute | Whois = Finger | PortScan '

Please select a network interface for information

Network Interface (en0) o ]
Interface Information Transfer Statistics
Hardware Address 00:17:f2:01:62:30 Sent Packets 11299819
IP Address(es) 10.0.16.36 Send Errors 0
Link Speed 100 Mb Recv Packets 10926997
Link Status Active Recv Errors 0
Vendor Intel Collisions 0

Model 80003 ESB2

BN

Obtaining the Host Name

If you have been informed by your COMSOL representative that you need to run
the FlexNet license manager for your installation, then you also need the Host
Name. To get the Host Name, launch the Terminal application; then enter
hostname at the terminal prompt.

If your network administrator prefers to use a fixed IP address for this particular
computer, this IP Address could be optionally used in place of the Host Name.
For more information on license manager installation, see “License Manager
Installation on Mac OS X” on page 61.

Obtaining the License File from a COMSOL Representative

Send the hostid information, as well as Host Name, if applicable, in an email to
your COMSOL representative, who will respond with an email with an attached
license file (1icense.dat). Save this file to any location on your computer. You
need to refer to it during installation. The license file is a text file. Below is an
example of the contents of a license.dat file for a Single User License on Mac.
This example license file shows that the licensed products are
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COMSOL Multiphysics, Particle Tracing Module, Subsurface Flow Module, and
LiveLink™ for Excel®.

# COMSOL 4.4 NSL License No: 1234567 Windows/Mac
# Visit www.comsol.com/install for latest installation instructions

FEATURE SERIAL LMCOMSOL 4.32 permanent uncounted \
VENDOR_STRING=C, 18000100200 HOSTID=ANY sort=100 SN=1234567 \
TS_OK SIGN=8045890A6FE4

FEATURE COMSOL LMCOMSOL 4.32 permanent uncounted HOSTID="70f2b13f4dfd \
0116b8cc761a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=E607EB680852

FEATURE PARTICLETRACING LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="i86_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3835733C6290

FEATURE SUBSURFACEFLOW LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="186_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=3A9BA162C9E4

FEATURE LLEXCEL LMCOMSOL 4.32 permanent uncounted HOSTID="70ft1ail2f4dfc \
0026b9cc760a" PLATFORMS="i86_n x64_n i86_mac x64_mac" \
SN=2076312 SIGN=EE9C11E44356

FEATURE COMSOLGUI LMCOMSOL 4.32 permanent uncounted \
HOSTID="70f1a12f4dfc 0026b9cc760a" PLATFORMS="186_n x64_n \
i86_mac x64_mac" SN=2076312 SIGN=0D0A83382550

A Single User License file can normally not be edited or changed in any way by
the user but has to be identical to the one sent to you by a COMSOL
representative. However, if you were sent a license file that requires a license
manager, then minor edits are required. For information on the type of license file
required for installations using a license manager, see “The License File” on page
62.

Registering with COMSOL Access

Once you have saved your license file, follow these steps to register or login to
COMSOL Access and to start the installation:

Click the link for downloading the software as given in the software download
email from your COMSOL representative. This link is identical or similar to:
www.comsol.com/product-download.

If you haven’t already created a COMSOL Access account, you will be
prompted to create it. While creating the account, point to your license file
(license.dat) to associate it with your account information.

If you already created a COMSOL Access account, then you can associate the
license file on the COMSOL Access page with your account under Manage
Licenses at www.comsol.com /access/licenses/

Continue with the instructions in the next section.
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DOWNLOADING THE COMSOL INSTALLER
I Go to the web page www.comsol.com/product-download.

2 You are now given the option of installing COMSOL using the Online Installer.
(For the DVD option see “Installation from Downloaded DVD Image” on
page 11.) In addition, there are two further options of Compact Installation or
Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.

Selection one of the options for Compact Installation or Full Installation.

Clicking one of the install buttons starts the download of the COMSOL Installer.
For Mac, the file to download is called COMSOL44_mac . dmg for the Full
Installation and COMSOL44_compact_mac.dmg for the Compact Installation.

STARTING THE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the
installation process. Start the COMSOL Installer by first mounting the
downloaded file by double-clicking it. Then run the COMSOL Installer
application COMSOL Installer.The COMSOL 4.4 Installer window should now
appear. Now continue with the instructions in the section “Running The
COMSOL Installer” on page 58.

Installation from Downloaded DVD Image

Installation from a DVD where the DVD image is downloaded from COMSOL
for off-line installation requires you to first create a COMSOL Access account as
described in the section “Installation Over the Internet” on page 7.
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I Once you are logged in to COMSOL Access, you are now given the option of
installing COMSOL using the Online Installer or to download the DVD Image
for Offline Installation. This section covers the DVD Image option. In addition,
there are two further options of Compact Installation or Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.

2 In the section for the DVD Image option, click one of the buttons for Compact
DVD Download or Full DVD Download. Clicking one of the install buttons starts
the download of the COMSOL DVD Image. The file to download is called
COMSOL44_dvd.1iso.

3 When you have downloaded the DVD image, you can install directly from the
downloaded DVD image by double-clicking it to mount it. Alternatively, burn
the DVD image to a disc to install. If you want to burn the DVD image to a
disc:

a Launch the Disk Utility application from Applications/Utilities.

b Click the Burn toolbar button. Select the DVD image in the file dialog box
and open it.

c Insert an empty DVD in the DVD drive and click Burn in the dialog box in
Disk Utility.

Starting the Installer from DVD or DVD Image

This section applies if you have received a DVD from a COMSOL representative
or if you have burned a DVD image downloaded from COMSOL for off-line
installation.

The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:
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I Insert the COMSOL DVD into the DVD drive (or mount the image).
2 Launch the COMSOL Installer application from the Finder.

3 The COMSOL 4.4 Installer window appears. Now continue with the
instructions in the section Running The COMSOL Installer below.

Installation from USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:

I Connect the USB Flash Drive to your computer.
2 Launch the COMSOL Installer application from the Finder.

3 The COMSOL 4.4 Installer window appears. Now continue with the
instructions in the section Running The COMSOL Installer below.

Running The COMSOL Installer

The steps for running the COMSOL Installer are independent of the installation
media option you used. If you have followed the above instructions, the
COMSOL Installer should now appear. Now continue with the instructions for
Windows in the section “Running the COMSOL Installer” on page 13. The
procedure is the same for Mac OS X with the following exceptions:

COMSOL does not work if the path to the COMSOL folder, or the name
of the COMSOL folder itself, contain spaces.

You cannot browse to the MATLAB installation directory directly. You
need to enter it manually. MATLAB is installed in the /Applications
directory, for example, as /Applications/MATLAB_R2013b.app.
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Automated Installation

You can install COMSOL using an automated installation process with minimal
user interaction. This method requires installation from DVD or DVD image. The
documentation on how to create an answer file is available in the template,
setupconfig.ini, which is available on the DVD. When an answer file is
created, start the installation by running

<path to DVD>/setup -s <answer file path>

where <answer file path> is the path to the answer file.

Removing (Uninstalling) the COMSOL Installation

The COMSOL 4.4 installation adds files only in the COMSOL44 folder. To
remove the COMSOL installation, delete the COMSOL44 folder including all
subfolders.

Product Updates and Model Library Update

COMSOL periodically releases product updates with improvements and
corrections to reported problems. By default, COMSOL checks for updates at
startup. You can turn this feature on and off from the COMSOL Desktop
Preferences Window. Here you can also configure settings for the Model Library
Update.

The COMSOL Model Library is updated on a regular basis by COMSOL. To
open the Model Library Update window from the File>Help menu (Windows
users) or from the Help menu (Mac and Linux users), select Update COMSOL
Model Library.

This connects you to the COMSOL Model Update website where you can access
the latest models and model updates. This includes models that have been added
or improved since the latest product release.

Using the Updates section in the Preferences dialog box, which you open from
the COMSOL Desktop, you can configure proxy server settings as well as model
and documentation directories for the Model Library Update. See the COMSOL
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Multiphysics Refevence Manual for more information including command-line
options for the Model Libraries.

Changing the Path to the MATLAB® Installation

You can change the path to the MATLAB installation in the Preferences window
accessed from the Options menu of the COMSOL Desktop. For more
information, see the LiveLink™ for MATLAB® documentation.
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License Manager Installation on Mac OS X

Many of the instructions for installing the FlexNet license manager are similar to
those for Windows. This section covers only the differences when installing on
Mac OS X. For general information on the license manager software, see “License
Manager Installation on Windows” on page 33.

FlexNet License Manager Software Components

The license manager consists of the following software components:
e License manager daemon (1mgrd)

* Vendor daemon (LMCOMSOL)

® FlexNet utility program (1mutil and others)

The two daemons (1mgrd and LMCOMSOL) run on the license server. When a user
starts COMSOL on a client computer, communication is established through the
network from the client to the license server and the license manager daemon
(1mgrd). That daemon in turn makes a request to the vendor daemon (LMCOMSOL ),
which releases licenses according to information in the license.dat file. The
FlexNet utility programs are used to handle license server management tasks.

FlexNet License Manager Documentation

For detailed information on the FlexNet license manager software, click the
button and choose Help>Documentation (Windows) or select
Help>Documention (Mac and Linux) and scroll to the bottom of the page to
locate a PDF copy of the FlexNet License Administration Guide.

License Manager Installation on Mac OS X | 6 I



The License File

The license file for use on Mac OS X is identical to that of Windows. See “The
License File” on page 35 for more information.

Installing the License Manager

The FlexNet license manager is automatically installed when installing COMSOL
unless otherwise specified on the Features page of the COMSOL Installer; see
“Features Page” on page 19. The check box for the license manager components
can be found last in the list of software components.

Ifyou want to install COMSOL on the same computer as the license manager, first
perform a complete COMSOL installation including the license manager software
components. When finished, skip the remainder of this section and continue with
“Starting the License Manager” on page 62.

To install only the license manager, follow the installation instructions for
COMSOL earlier in this document and, on the Features page, clear all check
boxes except the one for the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation
process with minimal user interaction; for this option, see “Automated
Installation” on page 59. Set 1icmanager = 1 in the answer file to install the license
manager.

Starting the License Manager

Either start the license manager manually or let it run automatically at startup.

STARTING THE LICENSE MANAGER MANUALLY
To start the license manager manually:
I Launch the Terminal application.

2 Change directory to the license/maci64 directory:
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cd /Applications/COMSOL44/1license/maci64

3 Then enter
./1lmgrd -c ../license.dat -1 /var/tmp/comsol44.log

The server is now ready to distribute licenses over the network. It writes any debug
information to the log file /var/tmp/comsol44.1log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT STARTUP

A folder comsoL_Lmgr located in the folder COMSOL44/1icense/maci64 contains a
script that can automatically start the license manager when you start the
computer. By installing and configuring this folder, the license manager does not
need to be started manually.

I Go to the top level /Library folder on your startup disk.

In the Library folder, create a folder StartupItenms if it does not already exist.

Open the file COMSOL_Lmgr in a text editor, for example, TextEdit.
Edit the line
FP=<COMSOLPATH>
by replacing <COMSOLPATH> with the path to the COMSOL folder. If
COMSOL is installed in the Applications folder this path is
FP=/Applications/COMSOL44

6 Edit the line
USERNAME=<username>

2
3 Move or copy the folder COMSOL_Lmgr to the StartupItems folder.
4
5

by replacing <username> with your username.

To run the comsoL_Lmgr file it must have the correct file permission that
include executable permission for the root user. To make sure that it has
the correct permission, enter the following commands:

sudo chown -R root:wheel /Library/StartupItems/COMSOL_Lmgr

sudo chmod -R 0755 /Library/StartupItems/COMSOL_Lmgr

Restart the computer to test the license manager installation. During
startup a message Starting COMSOL License Manager should appear.
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Verifying that the License Manager is Running

Once you start the license manager, it is good practice to verify that the license
manager processes are running. Start the Activity Monitor and check for the
vendor daemon (LMCOMSOL) and the license manager (1mgrd) in the list of
processes.

Starting COMSOL

After the installation is complete and the license manager daemons are running on
the license server, you can start using COMSOL. For more information on how
to run COMSOL, see “Running COMSOL on Mac OS X” on page 66.

Changing the License

If you have received a new license file—for example, when adding COMSOL
products to an existing license—replace the current license file with the new one.
Double-check the contents of this file to make sure it lists the products that the
license includes.

When the license file has changed, you must restart the license manager;
otherwise, it continues to use the old license file still in memory.

RESTARTING THE LICENSE MANAGER

To restart the license manager:

I Launch the Terminal application.

2 Change the directory to the license/maci64 (64-bit)
cd /Applications/COMSOL44/1license/maci64

3 Enter the commands

./1lmdown -c ../license.dat
./1lmgrd -c ../license.dat -1 /var/tmp/comsol44.log
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OBTAINING A HOSTID
If you need to verify the hostid of the license server, you can follow the steps in
“Obtaining the Hostid” on page 54. Alternatively, if COMSOL is already installed
on the license server, you can determine the hostid by executing the 1mhostid
command

COMSOL44/1icense/maci64/1mhostid

The hostid is typically the Ethernet address (also called a MAC address) of the
network card of your computer. An Ethernet address has six bytes, each with two
hexadecimal digits. Thus, the full hostid has twelve hexadecimal digits.

Troubleshooting License Errors

If you have questions or problems with your installation, see “Troubleshooting
License Errors” on page 91.
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Running COMSOL on Mac OS X

The COMSOL Applications

After the installation is finished there are several COMSOL applications available.
How many are available depends which products and licenses you have:

COMSOL Multiphysics This is the primary application for running COMSOL
Multiphysics. It launches COMSOL Multiphysics as a standalone application.

COMSOL Multiphysics (Classkit License) This application launches COMSOL
Multiphysics for a Classkit License. This application is only available if you have a
Classkit License.

COMSOL with MATLAB Use this application for running COMSOL with
LiveLink™ for MATLAB®. This application is only available if you have a
LiveLink™ for» MATLAB® license.
The COMSOL with MATLAB application requires that you use the X11
application together with MATLAB. The X-Windows application
OroborOSX is not supported. On Mac OS X 10.6 Snow Leopard you

need to quit the Terminal application prior to running the COMSOL with
MATLAB application.

COMSOL Multiphysics Server This application launches the Terminal
application and starts a COMSOL Server in a terminal window.

COMSOL Updates This application checks for available product updates on
www.comsol.com.

The COMSOL applications do not work if moved outside the COMSOL
folder. Create an alias if, for example, a desktop icon is required.
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Running COMSOL from a Terminal Window

COMSOL can also be launched from a terminal window using the shell script
COMSOL44 /bin/comsol.

To run the comsol command more easily, include the COMSOL44/bin directory in

the path or make a symbolic link from /usr/bin/comsol to the comsol script.

Those with administrator privileges can create a symbolic link with the command
sudo 1n -s /Applications/COMSOL44/bin/comsol /usr/bin/comsol

(assuming COMSOL is installed in the Applications folder). This command asks

for a password before creating the link.

The comsol command must not be moved from the COMSOL44/bin folder.
The COMSOL applications also use this script.

RUNNING A CLASSKIT LICENSE

To start COMSOL using a Classkit License, start COMSOL from the terminal
window using the -ckl option, for example,
comsol -ckl

Running COMSOL in Client-Server Mode

When you start COMSOL by, for example, launching the COMSOL Multiphysics
application, COMSOL is run as a single application that includes the functionality
of both the COMSOL Client and COMSOL Server, as explained later in this
section. However, the COMSOL Client/Server architecture lets you access the
COMSOL Server—the COMSOL computational engine—as a separate process.
For example, the COMSOL Desktop can act as a COMSOL Client when
connected to a COMSOL Server.
The license server is not the same as a COMSOL server. The license
manager can run on a computer different from both the ones used by
COMSOL Desktop and COMSOL Server.
You need a Floating Network License to run the COMSOL Server and the
COMSOL Client on separate computers. However, any COMSOL license is
sufficient for running the Client and the Server on the same computer.
The Client and Server need not run on the same platform. For example, you can
run the COMSOL Desktop on Mac connecting to a COMSOL Server on a
Windows or Linux computer. This enables offloading heavy-duty computations
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from your personal laptop or desktop to run just the COMSOL Desktop graphical
user interface. A typical use would be to run the COMSOL Server on a computer
with large amounts of memory (RAM) and processing power and to use your
personal computer for pre- and postprocessing with the COMSOL Desktop.

STARTING A COMSOL SERVER

To start the COMSOL Server, run the COMSOL Server application. A terminal
window appears asking you for a username and password. You can use any
username and password of your choice, it is only used for connecting a COMSOL
Client with a COMSOL Server.

When the COMSOL Server starts, it listens for a COMSOL Client connection on
the port listed in the command window.

Connecting a COMSOL Client to a COMSOL Server

You can start a COMSOL Client session from the COMSOL Desktop by selecting
Connect to Server from the File menu in the COMSOL Desktop. When you start
the Client, a Connect to Server window appears prompting you for a computer
name (Server) where the COMSOL Server is running, Port number, Username,
and Password.

800 Connect to Server

Server User
Server: |ocalhost Username:  paul
Port: 2036 Password: ssssssssssssssas

@I Remember password

Cancel OK

Once you have filled out this information and clicked 0K, the COMSOL Server
terminal window displays information that a COMSOL Client has connected. For
more information on running COMSOL in Client/Server mode, see the
COMSOL Multiphysics Reference Manual.

Running COMSOL in Batch Mode

You can submit COMSOL batch jobs from the COMSOL Desktop and the

command line. To run a COMSOL batch job, you need to make the Batch feature
visible: in the Model Builder tree, click the Show button (& ) and select Advanced
Study Options. In the Model Builder, right-click a Study node and select Batch to
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create batch jobs. From the terminal window, you can start batch jobs using the
comsol batch command. This is an example of how such a command could look:

comsol batch -inputfile in.mph -outputfile out.mph
To run a specific study add the command line option -study <tag>, where
<tag> is the tag of the study to run, for instance, std1. To see the tag, select Model
Builder Node Label>Show Name and Tag in the COMSOL Desktop (on the Home
toolbar in Windows, or from the Windows menu for Linux and Mac).

The COMSOL Multiphysics Reference Manual includes a dedicated section on
running COMSOL from the terminal window, including a list of COMSOL
commands and associated syntax.

Running COMSOL on Multicore Computers

COMSOL supports two modes of parallel operation: shared-memory parallel
operations and distributed-memory parallel operations, including cluster support
for Windows and Linux. This section covers shared-memory processing, or
multithreading, which is important for the performance of COMSOL
computations. Some terms that are frequently used in when describing
multithreading are:
e Core: The core is a processor core used in shared-memory parallelism by a
computational node with multiple processors.

o Speedup is how many times faster a job runs on N cores compared to 1 core,
on a specific compute node. The speedup depends on the simulation type,
the hardware used, and hardware drivers used.

On Mac OS X, the default number of processor cores used by COMSOL is the
total number of available physical cores. For example, if you have a 2 x dual core
machine, 4 cores are used in parallel by a COMSOL process.

SHARED-MEMORY OPTIONS

From the terminal window, use the comsol command option -np to control the
number of cores and processors used. The default is to use all available cores and
processors. For example:

comsol -np 2

launches COMSOL using 2 cores (if available).

You can experiment to find the options that work best for your configuration. For
more information see the COMSOL Multiphysics Reference Manual.
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Running COMSOL on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the
command line. To run COMSOL on a cluster, you need to make the cluster
feature visible: in the Model Builder tree, click the Show button (& ) and select
Advanced Study Options. Then in the Model Builder, right-click a Study node and
select Cluster Computing or Cluster Sweep to create cluster jobs. Cluster computing
requires a Floating Network License.

COMSOL cannot be run on a cluster running Mac OS X; however, you
can use the Cluster Computing or Cluster Sweep feature to connect to a
Windows or Linux cluster.

A tutorial model for cluster testing is included in the Model Libraries window
under COMSOL Multiphysics>Tutorial models>micromixer_cluster.

For more information about how to run COMSOL in parallel on clusters, see the
COMSOL Multiphysics Reference Manual. For installation on Clusters, see
“Cluster Installation” on page 32 for Windows and “Cluster Installation” on page
78 for Linux.

Running COMSOL on the Cloud

COMSOL supports cloud computing using Linux through Amazon Elastic
Compute Cloud™ (Amazon EC2)™. See the PDF version of Running COMSOL
on the Amazon™ Cloud for further information: www.comsol.com /ec2_manual.
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Installing on Linux

INSTALLATION OVER THE INTERNET

Installation of any paid-for license on Linux requires a license file, which is sent to
you by your COMSOL representative by email. To be able to generate the license
file, information about your hardware is needed in the form of a hostid (host ID).
The hostid is used to lock the license to your hardware and needs to be sent by
you to a COMSOL representative prior to the license file being generated.
A trial license can be given to you with the intention to test the software
without any payment obligation for noncommercial or nonproduction
use. This option is not available in all regions. For installation of a Single
User Trial License on Linux, you can follow the same instructions as for a
paid-for license.

Obtaining the Hostid

Follow these steps to obtain a hostid:
I Start a Terminal window.

2 Enter /sbin/ifconfig ethO

This displays the Ethernet address (also called a MAC address) which consists

of six bytes displayed as six pairs of hexadecimal digits such as
00:40:05:16:E5:25.

Obtaining the Host Name

If you have been informed by a COMSOL representative that you need to run the
FlexNet license manager for your installation, then you also need the Host Name:

I To get the Host Name, start a Terminal window.
2 Enter hostname at the terminal prompt.

If your network administrator prefers to use a fixed IP address for this particular
computer, this IP Address can be optionally used in place of the Host Name. For
more information on license manager installation see “License Manager
Installation on Linux” on page 80.

Obtaining the License File from a COMSOL Representative

Send the hostid information, as well as Host Name, if applicable, in an email to
your COMSOL representative, who will respond by email with an attached license
file (1icense.dat). Save this file to any location on your computer. You need to
refer to it during installation. A trial license file for Linux cannot normally be
edited or changed in any way by the user but has to be identical to the one sent to
you by a COMSOL representative. However, if you were sent a license file that
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requires a license manager, then minor edits are required. For information on the
type of license file required for installations using a license manager, see “The
License File” on page 35.

Registering with COMSOL Access

Once you have saved your license file, follow these steps to register or login to
COMSOL Access and to start the installation:

Click the link for downloading the software as given in the software download
email from your COMSOL representative. This link is identical or similar to:
www.comsol.com/product-download

If you haven’t already created a COMSOL Access account, you will be
prompted to create it. While creating the account, point to your license file
(license.dat) to associate it with your account information.

If you already created a COMSOL Access account, then you can associate the
license file on the COMSOL Access page with your account under Manage
Licenses at www.comsol.com/access /licenses

Continue with the instructions in the next section Downloading the COMSOL
Installer.

DOWNLOADING THE COMSOL INSTALLER

Go to the web page www.comsol.com/product-download.

2 Select installation for Linux 32-bit or Linux 64-bit.

3 You are now given the option of installing COMSOL using the Online Installer.

(For the DVD option see “Installation from Downloaded DVD Image” on
page 11.) In addition, there are two further options of Compact Installation or
Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.

4 Selection one of the options for Compact Installation or Full Installation.
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Clicking one of the install buttons starts the download of the COMSOL Installer.
For Linux, the file to download is given a name depending on whether it is for
32-bit or 64-bit Linux and whether it is for a compact or full installation:

e comsol44_compact_glnx86.zip (Compact, 32-bit)
e comsol44_compact_glnxa64.zip (Compact, 64-bit)
® comsol44_glnx86.zip (Full, 32-bit)

e comsol44_glnxa64.zip (Full, 64-bit)

STARTING THE INSTALLER FOR INSTALLATION OVER THE INTERNET

The COMSOL Installer is a user interface tool that guides you through the
installation process. Start the COMSOL Installer by first unzipping the
downloaded file and then running the setup script. The COMSOL 4.4 Installer

window should now appear. Now continue with the instructions in the section
“Running The COMSOL Installer” on page 75.

Installation from Downloaded DVD Image

Installation from a DVD where the DVD image is downloaded from COMSOL
for off-line installation requires you to first create a COMSOL Access account as
described in the section “Installation Over the Internet” on page 7.

I Once you are logged in to COMSOL Access, you are now given the option of
installing COMSOL using the Online Installer or to download the DVD Image
for Offline Installation. This section covers the DVD Image option. In addition,
there are two further options of Compact Installation or Full Installation:

- Compact Installation: Includes the on-line documentation. The model library
tutorials are stripped of solutions, which reduces download time. The size of
this download ranges from 600 MB to 1.6 GB depending on your license.

- Full Installation: Includes the full documentation and the complete model
library with meshes and solutions for your licensed products. The size of this
download ranges from 1.0 GB to 3.7 GB depending on your license.

If you have problems downloading (such as Error downloading file.
Connection refused: connect), please review this knowledge base entry:
www.comsol.com/support/knowledgebase /1149. If you still have
problems, please contact your local COMSOL representative or technical
support from the Support Center page at www.comsol.com/support.
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2 In the section for the DVD Image option, click one of the buttons for Compact
DVD Download or Full DVD Download. Clicking one of the install buttons starts
the download of the COMSOL DVD Image. The file to download is called
COMSOL44_dvd.1iso.

3 When you have downloaded the DVD image, burn the DVD image to a disc.
Use a DVD burning tools or command such as cdrecord to burn the DVD.
Alternatively, directly mount the DVD using a loopback device:

mount -o loop COMSOL44_dvd.iso /mnt

Starting the Installer from Downloaded DVD Image

This section applies if you have burnt a DVD image downloaded from COMSOL
for off-line installation.

STARTING THE INSTALLER FROM A DOWNLOADED DVD IMAGE

The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:

I Make sure the COMSOL DVD is in the DVD drive (or mount the image).
2 Type /mnt/setup

3 The COMSOL 4.4 Installer window appears. Now continue with the
instructions in the section “Running The COMSOL Installer” on page 75.

Installation from DVD

This section applies if you have received a DVD from a COMSOL representative.

STARTING THE INSTALLER FROM A DVD

The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:

I Insert the COMSOL 4.4 DVD into the DVD drive.

2 If the DVD is not mounted automatically by your operating system, use the
mount command to mount it.

3 To start the installation, enter the command
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sh drivepath/setup

where drivepath is the mount point of the DVD drive, for example
/media/cdrom.

You might have to mount the DVD with the option -0 exec if your Linux
mounts the DVD without execute options by default.

The COMSOL 4 4 Installer window appears. Now continue with the instructions
in the section “Running The COMSOL Installer” on page 75.

Installation from USB Flash Drive

This section applies if you have received a USB Flash Drive from a COMSOL
representative.

STARTING THE INSTALLER FROM A USB FLASH DRIVE

The COMSOL Installer is a user interface tool that guides you through the
installation process. To start the installer:

I Connect the USB Flash Drive to your computer.

2 If the USB Flash Drive is not mounted automatically by your operating system,
use the mount command to mount it.

3 To start the installation, enter the command

sh drivepath/setup

where drivepath is the mount point of the USB Flash Drive, for example
/media/usb.

You might have to mount the USB Flash Drive with the option -0 exec if your
Linux mounts the USB Flash Drive without execute options by default.

4 The COMSOL 4.4 Installer window appears. Now continue with the
instructions in the section Running The COMSOL Installer below.

Running The COMSOL Installer

The steps for running the COMSOL Installer are independent of the installation
media option you used. If you have followed the above instructions, the
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COMSOL Installer should now appear. For a detailed description and screen
shots of the different COMSOL Installer steps, see the instructions for Windows
in the section “Running the COMSOL Installer” on page 13. The procedure for
running the COMSOL Installer on Linux is similar and summarized below with
the differences from installation on Windows highlighted:

I When the installer window appears, click New Installation.

2 Read the license agreement, select | accept the terms of the license agreement,
specify License information, and then click Next.

3 Ifyou have a Named Single User License and you are installing the software on
the license server, a dialog box opens up and you are asked to enter the user to
bind the license to.

4 Select for which platforms (32-bit or 64-bit Linux) that you wish to install and
click Next.

5 Select the features to install and specify the path to the COMSOL installation
directory.

6 Click Next.

7 If you have licensed LiveLink™ for MATLAB®, then specify the MATLAB root
folder.

8 Click Next.
9 Click Install to start the installation.

10 When the installation process is finished, the Finish window appears. If errors
arose during installation, this window issues a notification. The installer also
writes a log entry into the text file comsolsetup.log, which resides in the
specified installation directory. Click Finish to quit the installer. If you installed
from DVD, use the unmount and eject commands to unmount and eject the
DVD. Some Linux configurations automatically unmount and eject the DVD
when you press the DVD drive button.

Il To make sure all users can easily start COMSOL, include the comsol44/bin
directory in all users’ paths or make a symbolic link from
/usr/local/bin/comsol to the comsol command (see the Linux 1n command).

Web Browser for Viewing the Documentation

The file browser in the bin directory attempts to start common web browsers that
are available with the supported Linux versions. Edit the file in any text editor to
adjust it for your preferred web browser. The variable BROWSERS in this file contains
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a list of web browsers in order of preference. If you want to make a specific browser
the preferred web browser, put it first in the list.

Automated Installation

You can install COMSOL using an automated installation process with minimal
user interaction. This method requires installation from DVD or DVD image. The
documentation on how to create an answer file is available in the template,
setupconfig.ini, which is available on the DVD. When you have created an
answer file, start the installation by running

<path to DVD>/setup -s <answer file path>

where <answer file path> is the path to your answer file.

Removing (Uninstalling) the COMSOL Installation

The COMSOL 4 .4 installation adds files only in the comso144 directory. To
remove the COMSOL installation, simply delete the comso144 directory including
all subdirectories.

Product Updates and Model Library Update

COMSOL periodically releases product updates with improvements and
corrections to reported problems. By default, COMSOL checks for updates at
startup. You can turn this feature on and off from the COMSOL Desktop
Preferences Window. Here you can also configure settings for the Model Library
Update.

The COMSOL Model Library is updated on a regular basis by COMSOL. To
open the Model Library Update window from the File>Help menu (Windows
users) or from the Help menu (Mac and Linux users), select Update COMSOL
Model Library.
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This connects you to the COMSOL Model Update website where you can access
the latest models and model updates. This includes models that have been added
or improved since the latest product release.

Using the Updates section in the Preferences dialog box, which you open from
the COMSOL Desktop, you can configure proxy server settings as well as model
and documentation directories for the Model Library Update. See the COMSOL
Multiphysics Reference Manual for more information including command-line
options for the Model Libraries.

Changing the Path to the MATLAB® Installation

You can change the path to the MATLAB installation in the Preferences window
accessed from the Options menu of the COMSOL Desktop. For more
information, see the LiveLink™ for MATLAB® documentation.

Cluster Installation

COMSOL supports two modes of parallel operation: shared-memory parallel
operations and distributed-memory parallel operations, including cluster support.
This section is dedicated to distributed-memory parallel installation.

COMSOL can distribute computations on compute clusters using the MPI
model. One large simulation can be distributed across many compute nodes. Also,
parametric sweeps can be done with individual parameter cases distributed to each
cluster node.

SYSTEM REQUIREMENTS

The installation instructions above can also be followed for clusters. COMSOL
supports shared-memory parallelism and distributed-memory parallelism on
32-bit and 64-bit Linux. For details on system requirements, see
www.comsol.com/system-requirements.

LICENSE MANAGER

COMSOL requires a Floating Network License for running on clusters. Please
check the license file for the CLUSTERNODE feature, which needs to be present
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to enable the cluster computing functionality. The license manager needs to be
accessible from all nodes in the cluster. Therefore it is often a good idea to have it
run on the head node.

INSTALLATION FOLDER

The COMSOL installation folder should be shared between all compute nodes
and the head node.

FEATURES

During installation, make sure the Cluster Components feature is selected.

ACCESS TO CLUSTER

If you work on a computer that is not on the cluster, install COMSOL on that
computer. Typically, you use a scheduler to launch jobs on the cluster. Make sure
the scheduler client software is installed on that computer. You can configure the
installation to use the scheduler by changing the comsol. ini file according to the
section on MPI Options in the COMSOL Multiphysics Reference Manual.

For more information on installing and running COMSOL on clusters, see
“Running COMSOL on Clusters” on page 88 and the COMSOL Multiphysics
Reference Manual.
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License Manager Installation on Linux

You do not need to install the license manager if you are installing a trial version.
The paid-for version on Linux, however, always requires a running license
manager. Many of the instructions for installing the FlexNet license manager are
similar to those for Windows. This section covers only the differences when
installing on Linux. For general information on the license manager software, see
“License Manager Installation on Windows” on page 33.

FlexNet License Manager Software Components

The license manager consists of the following software components:
e License manager daemon (1mgrd)

* Vendor daemon (LMCOMSOL)

e FlexNet utility program (1lmutil and others)

The two daemons (1mgrd and LMCOMSOL) run on the license server. When a user
starts COMSOL on a client computer, communication is established through the
network from the client to the license server and the license manager daemon
(1mgrd). That daemon in turn makes a request to the vendor daemon (LMCOMSOL ),
which releases licenses according to information in the license.dat file. The
FlexNet utility programs are used to handle license server management tasks.

FlexNet License Manager Documentation

For detailed information on the FlexNet license manager software, click the
button (File menu) and choose Help>Documentation (Windows) or select
Help>Documentation (Mac and Linux) and scroll to the bottom of the page to
locate a PDF copy of the FlexNet License Administration Guide.
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The License File

The license file for use on Linux is identical to that for Windows, except in the case
of'a Named Single User License, which is described below. See “The License File”
on page 35 for general license file information.

LICENSE FILES FOR NAMED SINGLE USER LICENSE

If you have a Named Single User License the installer automatically creates an
options file that binds the license to the named user. This section describes the
format of the options file and how the license.dat file points to the options file.

Below is an example of an options file, LMCOMSOL . opt, for a user “philip” who has
access to COMSOL Multiphysics, the Structural Mechanics Module, and the
CAD Import Module. Notice that to access COMSOL Multiphysics, the options
file must include both the COMSOL and the COMSOLGUI features:

INCLUDE COMSOL USER philip

INCLUDE COMSOLGUI USER philip

INCLUDE CADIMPORT USER philip

INCLUDE CADREADER USER philip

INCLUDE STRUCTURALMECHANICS USER philip
Each INCLUDE row in the LMCOMSOL . opt file has a corresponding FEATURE row in the
license.dat file (with the USER_BASED keyword). The second item on each
FEATURE row is the name of the feature for which you have a license.
For more information on which FEATURE items are available, see “The License
File” on page 35.
The license.dat file needs to point to the options file. The path to the options
file is indicated by the options keyword. If your options file is placed here:

/usr/local/comsol44/license/LMCOMSOL.opt

then the VENDOR row in license.dat should read

VENDOR LMCOMSOL port=1719 options=/usr/local/comsol44/license/LMCOMSOL.opt

Installing the License Manager

The FlexNet license manager is automatically installed when installing COMSOL
unless otherwise specified on the Features page of the COMSOL Installer; see
“Features Page” on page 19. The check box for the license manager components
can be found last in the list of software components.
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Ifyou want to install COMSOL on the same computer as the license manager, first
perform a complete COMSOL installation including the license manager software
components. When finished, skip the remainder of this section and continue with
Starting the License Manager below.

To install only the license manager, follow the installation instructions for
COMSOL earlier in this document and on the Features page, clear all check boxes
except the one for the license manager.

AUTOMATED LICENSE MANAGER INSTALLATION

Alternatively, the license manager can be installed using an automated installation
process with minimal user interaction, see “Automated Installation” on page 77.
Set licmanager = 1 in the answer file to install the license manager.

Starting the License Manager

You can start the license manager manually or it can run automatically at boot.

STARTING THE LICENSE MANAGER MANUALLY

To start the license manager manually, make the license/$arch directory the
current directory and enter
./1lmgrd -c ../license.dat -1 /var/tmp/comsol44.log

The server is now ready to distribute licenses over the network. It writes any debug
information to the log file /var/tmp/comsol44.1log.

STARTING THE LICENSE MANAGER AUTOMATICALLY AT BOOT

In order for the license manager to start automatically at boot, you need to add
Bourne shell commands to the appropriate boot script. You must be a superuser
(root) to edit boot scripts.

For security reasons, it is recommended that the daemons are not started
as root. Instead, use a dedicated username to start the license manager.
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The procedure for editing boot scripts on each platform appears in the following

table:

PLATFORM

PROCEDURE

SuSe Linux

Debian
Linux

Linux,
General

The following instructions should work for SuSE Linux distributions, where $arch
is either g1nx86 (32-bit Linux), or glnxa64 (64-bit Linux).
In the comsol44/1icense/$arch directory, enter the commands

cp rc.1lm /etc/init.d/comsol441m

chmod 755 /etc/init.d/comsol441m
Edit /etc/init.d/comsol441m, replacing dir with the full path to the $arch
platform directory, and replace username with an actual username.
Now create the following link

cd /etc/init.d/rc5.d

In -s ../comsol441lm S91comsol441lm
The following instructions should work for Debian Linux distributions, where
$arch is either g1nx86 (32-bit Linux), or glnxa64 (64-bit Linux).
Copy the file comsol44/1icense/$arch/1lm_comsol to /etc/init.d
Edit /etc/init.d/1m_comsol. Update the FP and MYUSER variables as
indicated in the file. Use the utility update-rc.d to automatically update the
system's init script links:

update-rc.d 1lm_comsol start 99 2 3 4 5 . stop 1 016 .
This means that the COMSOL license manager is started by runlevels 2, 3, 4, and
5, and stopped by runlevels O, |, and 6. Enter man update-rc.d for more
information on init scripts.
The following instructions should work for most Linux distributions, where $arch
is either g1nx86 (32-bit Linux) or glnxa64 (64-bit Linux).
Copy the file comsol44/1license/$arch/rc.1lm and paste it at the end of
/etc/rc.d/rc.local.

Replace dir in the code fragment with the full path to the $arch platform
directory, and replace username with an actual username.

Verifying that the License Manager is Running

Once you start the license manager, it is good practice to verify that the license
manager processes are running. Use administrative commands such as top or ps to
check that both the vendor daemon (LMCOMSOL) and the license manager
(Imgrd) are running.
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Starting COMSOL

After the installation is complete and the license manager daemons are running on
the license server, you can start using COMSOL. For more information on how
to run COMSOL, see “Running COMSOL on Linux” on page 85.

Changing the License

If you have received a new license file—for example, when adding COMSOL
products to an existing license—replace the current license file with the new one.
Double-check the contents of this file to make sure it lists the products that the
license includes.

When the license file has been changed, you must restart the license
manager; otherwise, it continues to use the old license file still in memory.

RESTARTING THE LICENSE MANAGER

To restart the license manager, make the license/$arch directory under the
COMSOL installation directory the current directory, then enter the following
commands:

./1lmdown -c ../license.dat
./1lmgrd -c ../license.dat -1 /var/tmp/comsol44.log

OBTAINING A HOSTID

If COMSOL is already installed on your license server, you can determine the
hostid by executing the 1mhostid command
comsol44/license/$arch/1lmhostid

where $arch is g1nx86 (32-bit Linux) or glnxa64 (64-bit Linux).

Troubleshooting License Errors

If you have questions or problems with your installation, see “Troubleshooting
License Errors” on page 91.
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Running COMSOL on Linux

Running COMSOL

If you are running a Linux version with a graphical desktop environment, you
might find a COMSOL Multiphysics icon that you can simply click to start
COMSOL. Alternatively, using a terminal window, you can run the comsol
command. If it is not available, ask your system manager to make it available to
you, or, if you have administrative privileges on your Linux system, add the comsol
command to the search path. The comsol command is located in the bin folder in
the COMSOL installation directory. This is a typical example of a command that
adds comsol to the search path is (assuming you are logged in as root):

1n -s /usr/local/comsol44/bin/comsol /usr/bin/comsol

Running COMSOL on Multicore Computers

COMSOL supports two modes of parallel operation: shared-memory parallel

operations and distributed-memory parallel operations, including cluster support

for Windows and Linux. This section covers shared-memory processing, or

multithreading, which is important for the performance of COMSOL

computations. Some terms that are frequently used in when describing

multithreading are:

e Core: The core is a processor core used in shared-memory parallelism by a
computational node with multiple processors.

o Speedup is how many times faster a job runs on N cores compared to 1 core,
on a specific compute node. The speedup depends on the simulation type,
the hardware used, and the hardware drivers used.

On Linux, the default number of processor cores used by COMSOL is the total
number of available physical cores. For example, if you have a 2 x dual core
machine, 4 cores are used in parallel by a COMSOL process.
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SHARED-MEMORY OPTIONS

From the Terminal window, use the comsol command option -np to control the
number of cores and processors used. The default is to use all available cores and
processors. For example:

comsol -np 2

launches COMSOL using 2 cores (if available).

You might need to experiment to find the options that work best for your
configuration. For more information see the COMSOL Multiphysics Reference
Manual.

Running COMSOL in Batch Mode

You can submit COMSOL batch jobs from the COMSOL Desktop and the
command line. To run a COMSOL batch job, you need to make the Batch feature
visible: in the Model Builder tree, click the Show button (& ) and select Advanced
Study Options. In the Model Builder, right-click a Study node and select Batch to
create batch jobs. From a terminal window, you can start batch jobs using the
comsol batch command. This is an example of such a command:

comsol batch -inputfile in.mph -outputfile out.mph
To run a specific study add the command-line option -study <tag>, where
<tag> is the tag of the study to run, for instance, std1. To see the tag, select Model

Builder Node Label>Show Name and Tag in the COMSOL Desktop (on the Home
toolbar in Windows, or from the Windows menu for Linux and Mac).

The COMSOL Multiphysics Reference Manual has a dedicated section on
running COMSOL from a terminal window, including a list of COMSOL
commands and associated syntax.

Running COMSOL in Client-Server Mode

When you start COMSOL by, for example, entering the comsol command with
no additional arguments, COMSOL is run as a single application that includes the
functionality of both the COMSOL Client and COMSOL Server, as explained
later in this section. However, the COMSOL Client/Server architecture lets you
access the COMSOL Server—the COMSOL computational engine—as a separate
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process. For example, the COMSOL Desktop can act asa COMSOL Client when
connected to a COMSOL Server.

The license server is not the same as a COMSOL Server. The license
manager can run on a computer different from both the ones used by
COMSOL Desktop and COMSOL Server.

You need a Floating Network License to run the COMSOL Server and the
COMSOL Client on separate computers. However, any COMSOL license is
sufficient for running the Client and the Server on the same computer.

The Client and Server need not run on the same platform. For example, you can
run the COMSOL Desktop on Windows connecting to a COMSOL Server on a
Linux computer. This enables offloading heavy-duty computations from your
personal laptop or desktop to run just the COMSOL Desktop graphical user
interface. A typical use would be to run the COMSOL Server on a computer with
large amounts of memory (RAM) and processing power and to use your personal
computer for pre- and postprocessing with the COMSOL Desktop.

STARTING A COMSOL SERVER
To start the COMSOL Server from a terminal window, run the comsol command
with the server argument:
comsol server
You are then prompted for a username and password. You can use any username

and password of your choice, it is only used for connecting a COMSOL Client
with a COMSOL Server.

When the COMSOL Server starts, it listens for a COMSOL Client connection on
the port listed in the command window.

Connecting a COMSOL Client to a COMSOL Server

You can start a COMSOL Client session from the COMSOL Desktop by selecting
Connect to Server from the File menu in the COMSOL Desktop. You can also
start a COMSOL Client session from a terminal window by running the comsol
command with the client argument:

comsol client
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When you start the Client, a Connect to Server window appears prompting you
for a computer name (Server) where the COMSOL Server is running, Port
number, Username, and Password:

Senver User

Senver: |localhost ||| usemame: |paul |

Port  [2036 | || Password

] Remember passward

Once you have filled out this information and clicked 0K, the COMSOL Server
terminal window displays information that a COMSOL Client has connected. For
more information on running COMSOL in Client/Server mode, see the
COMSOL Multiphysics Reference Manual.

Running a Classkit License

To start COMSOL using a Classkit License, start COMSOL using the -ckl
option:
comsol -ckl

Running COMSOL on Clusters

You can launch COMSOL cluster jobs from the COMSOL Desktop and the
command line. To run COMSOL on a cluster, you need to make the cluster
feature visible: in the Model Builder tree, click the Show button (“&F ) and select
Advanced Study Options. Then in the Model Builder, right-click a Study node and
select Cluster Computing or Cluster Sweep to create cluster jobs. Cluster computing
requires a Floating Network License.

The following terms occur frequently when describing the hardware for cluster
computing and shared memory parallel computing:

¢ Compute node: The compute nodes are where the distributed computing
occurs. Each distributed COMSOL process resides in a compute node and
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communicates with other compute nodes using MPI (message-passing
interface).

e Host: The host is a physical machine (hardware) with a network adapter and
unique network address. The host is part of the cluster. It is sometimes
referred to as a physical node.

e Core: The core is a processor core used in shared-memory parallelism by a
computational node with multiple processors.

The number of used hosts and the number of computational nodes are usually the
same. For some special simulation types, like very small simulations with many
parameters, it might be beneficial to use more than one computational node on
one host.

A tutorial model for cluster testing is included in the Model Libraries window
under COMSOL Multiphysics>Tutorial models>micromixer_cluster.

QUICK TROUBLESHOOTING

* Your first step is to make sure you have the latest release installed. Check that
you have COMSOL 4.4 or later and make sure to install the latest product
updates.

e If you get the error message Process status indicates that process is running,
then cancel any running jobs in the scheduler that you use. In the COMSOL
Desktop, locate the External Process page at the bottom right. Click the Clear
Status button.

For more information about how to run COMSOL in parallel on Linux clusters,
see the COMSOL Multiphysics Reference Manual. For installation on Clusters,
see “Cluster Installation” on page 78.

Running COMSOL on the Cloud

COMSOL supports cloud computing using Linux through Amazon Elastic
Compute Cloud™ (Amazon EC2)™. See the PDF version of Running COMSOL
on the Amazon™ Cloud for further information: www.comsol.com /ec2_manual.
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Running COMSOL with MATLAB

Running COMSOL with MATLAB starts a COMSOL Server and a MATLAB
Desktop. No COMSOL graphical user interface is involved. For a tutorial, see the
LiveLink for MATLAB User’s Guide.

To launch MATLAB and connect it to a COMSOL Server, run the command
comsol server matlab

STARTING COMSOL WITH MATLAB USING THE GRAPHICS SERVER

To display the plot in a COMSOL graphics window you need to run COMSOL
with MATLAB using the graphics server. To do so, start COMSOL with
MATLAB from a terminal window with the -graphics flag:

comsol server matlab -graphics

REQUIRED PROGRAMS FOR RUNNING COMSOL wiTH MATLAB

The xterm program is necessary for the command comsol server matlab. The
csh program is needed to call MATLAB functions from COMSOL.

e To install the missing packages on Debian and Ubuntu, type
sudo apt-get install xterm csh

* To install the missing packages on RedHat Enterprise and Fedora, type
sudo yum install xterm tcsh

e To install the missing packages on OpenSUSE, type
sudo zypper install xterm tcsh
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Troubleshooting License Errors

If you have questions or problems with your installation, start by checking the
COMSOL Support Knowledge Base at

www.comsol.com /support/knowledgebase / for up-to-date information about
installation and license issues. If this does not help, then please contact COMSOL
technical support at support@comsol.com.

THE COMSOL SUPPORT KNOWLEDGE BASE

The most important Knowledge Base entries for installation questions and license
errors are the following:

SUBJECT KNOWLEDGE BASE ENTRY

Could not obtain license for ~ www.comsol.com /support/knowledgebase /903
COMSOL Multiphysics GUI

Running COMSOL in parallel  www.comsol.com/support/knowledgebase /1001
on clusters

Updating the COMSOL www.comsol.com/support,/knowledgebase /1022
License Manager

COMSOL Installation www.comsol.com/support,/knowledgebase /1077
Companion

Error: An error has occurred.  www.comsol.com /support/knowledgebase /1083
See the log file C:\Users...

Selecting hardware for www.comsol.com/support/knowledgebase /1116
clusters

The COMSOL 44 tab is not ~ www.comsol.com/support/knowledgebase /1147
available in the Microsoft
Excel ribbon

Error: Error downloading file.  www.comsol.com/support/knowledgebase /1149
Connection refused: connect

You can also view videos about installation at:
www.comsol.com /video /browse /installation.

LICENSE ERRORS

This section summarizes the most common post-installation error messages
generated by COMSOL, and it gives some advice how to troubleshoot them. For
a complete list of error messages, see the FlexNet license manager documentation.
This documentation is shipped with your COMSOL installation; see “FlexN et®
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License Manager Documentation” on page 34 on where to find it.

If you need to review the license manager log file, or send it to COMSOL
technical support, this is where you usually find it (depending on choices you
made during the installation):

e Windows: C:\Program Files\COMSOL44\license\comsol44.log
e Mac OS X: /var/tmp/comsol44.1log

e Linux: /var/tmp/comsol44.log

If you need to access the license file, this is where you usually find it:
e Windows: C:\Program Files\COMSOL44\license\license.dat
e Mac OS X: /Applications/COMSOL44/license/license.dat

e Linux: /usr/local/comsol44/license/license.dat

ERROR MESSAGE EXPLANATION

License error A general license error has occurred. Check the error message for
details that might help solve the problem. If you need help in
interpreting the information, see the FlexNet License Manager
documentation or send the complete error message to
support@comsol.com.

License error: -1.  The license file is missing or your system settings don't allow you to
Cannotfindlicense  read the file. Review the license manager installation steps above and
file. check that you have administrative rights on your computer.

License error: -2.  There is a formatting problem with your license file. This can happen if
Invalid license file you edit it with a word processing software such as Microsoft Word
syntax. which inserts extra (invisible) characters. Use a plain text editor

instead (on Windows: Notepad, WordPad, or similar). Formatting
problems can also happen if the file is corrupted while being copied
or emailed from one computer to another.

License error: -4.  The license manager has detected that all available licenses of a
Licensed number  certain COMSOL product have been used by other users. Contact
of users already your license administrator and report this problem. You might need
reached. more licenses of one of the add-on products.

License error: -5.  The license manager has encountered a problem during startup.
No such feature Check the license manager log file for error messages.

exists. Please send the log file to support@comsol.com if you want help in

interpreting the information.

NOTE: The license manager creates the log file. If there is no log file,
make sure to first start the license manager. Please refer to one of the
License Manager Installation sections of this manual for instructions
how to install and start the COMSOL license manager.
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ERROR MESSAGE EXPLANATION

License error: -10.  This error message indicates that you have a time-limited (trial) license

Feature has and that your license has expired. Contact your license administrator

expired. to see if a more recent license file is available. You can also contact a
COMSOL representative to renew your time-limited license.

License error: -12.  Check that no firewall on the COMSOL client is preventing the
Invalid returned connection from the COMSOL client to the license server.

data from license ~ Temporarily disable any firewall on the COMSOL client to see if that
server system. helps.

Check that no firewall on the license server is preventing the
connection from the COMSOL client computer to the license
manager, or the connection from the Imgrd daemon and the
LMCOMSOL daemon.

If the problems remain, send the license manager log file to
support@comsol.com.
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ERROR MESSAGE

EXPLANATION

License error: -15.
Cannot connect to
license server
system.

License error: -39.
User/host not on
INCLUDE list for
feature.

The COMSOL license manager has not been installed or started yet.
If the first line of your license.dat file looks like this:

SERVER mylicserver 000123456789 1718
a license manager is required. Please refer to the License Manager
Installation sections of this manual for instructions on how to install
and start the COMSOL license manager.
Check that no firewall on the COMSOL client is preventing the
connection from the COMSOL client to the license server.
Temporarily disable any firewall on the COMSOL client to see if that
helps.

Check that no firewall on the license server is preventing the
connection from the COMSOL client computer to the license
manager.

Check that the 1icense.dat file on the COMSOL client computer
points to the correct license server host name. First, find the
license.dat according to the instructions above.
Check that the first line has the correct license server Host Name.
For example, if your license server Host Name is apollo, the first
row in the license.dat file should look like this:

SERVER apollo 000123456789 1718

If the COMSOL client computer does not recognize apollo as a
proper Host Name, it might help to instead use the fully qualified
domain name (apollo.thecompany.com) or the IP address. If
neither of these work, there might be a problem with DNS or the
HOSTS file on the client. Please ask your system administrator for
advice on how to connect with TCP/IP to the license server.

Finally, the license manager might have encountered a problem during
startup. Check the license manager log file for error messages.
NOTE: The log file is created by the license manager after it has been
started.

Please send the log file to support@comsol.com if you want help in
interpreting the information.

The error means that your username does not match the one listed in
the license-manager options file, LMCOMSOL . opt. To get access to
COMSOL, ask your license/system administrator for help. When the
username in the options file is changed, the license manager must be
shut down and restarted to give the new user immediate access to
COMSOL.
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ERROR MESSAGE EXPLANATION

License error: -88.  The software has detected that a system clock has been set back.

System clock has Please make sure that your computer's clock is set to the current local
been set back. time and date. If the problem remains check that there are no files on
your hard drive that have a future date.

License error: -96.  Please make sure that the SERVER host name in the 1icense.dat
License server file is valid and that the TCP/IP network connection between the
machine is down application computer and the license server is working properly.

or not responding.  This error could also indicate that your firewall is not configured
properly in order to let the license manager and vendor daemon
network traffic through (typically ports | 718 and 1719). It could also
indicate problems with other network security settings. Contact your
systems administrator for help.

License error: -97.  The license manager has encountered a problem during startup.

The desired Check the license manager log file for error messages.

vendor daemon is  NOTE: The log file is created by the license manager after it has been
down. started.

Please send the log file to support@comsol.com if you want help in
interpreting the information.
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